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fonctionnalités de votre 
nouveau lecteur MP3
Elégant, intelligent, fi able et très pratique : votre nouveau lecteur MP3 
est tout cela à la fois et plus encore! Sa forme compacte se glisse 
facilement dans votre poche et sa technologie de pointe vous offre une 
qualité de son et d’image exceptionnelle. Vous ne pourrez plus vous 
passer de votre nouveau lecteur MP3, que ce soit pour pratiquer une 
activité physique, télécharger vos chansons préférées, regarder des 
vidéos ou même écouter la radio. Utilisez-le ne serait-ce qu’une seule 
fois et vous vous demanderez comment vous avez pu vivre sans!

TOTALEMENT MULTIMEDIA
Nous l’appelons lecteur MP3 mais c’est bien 
plus que ça. Il permet d’affi cher des images, 
du texte, des vidéos et même d’écouter la 
radio.
La technologie intégrée Bluetooth sans fi l 
transforme votre lecteur MP3 en un véritable 
réseau personnel.

LA NAVIGATION TACTILE !
Le pavé tactile vous permet de naviguer 
dans les différents menus.

L'ALLIANCE PARFAITE DE LA FORME ET 
DU FOND
Le lecteur MP3 n’est pas seulement discret 
et élégant. Il est également facile à utiliser et 
à manipuler.

ECOUTE PROLONGEE ET DUREE DE 
TELECHARGEMENT REDUITE !
Une batterie entièrement chargée permet 
de lire jusqu’à 30 heures de musique ou 4 
heures de vidéo.
La durée de téléchargement a en outre été 
sensiblement réduite. Grâce au standard 
USB 2.0, le lecteur est bien plus rapide que 
les modèles utilisant le format USB 1.1.

UNE QUALITE D’ECOUTE 
EXCEPTIONNELLE
Votre nouveau lecteur MP3 intègre la 
technologie sonore exclusive DNSe™ 
(Digital Natural Sound engine) de Samsung, 
fonction permettant de fournir un son d’une 
pureté et d’une richesse incroyables pour un 
plaisir d’écoute inégalé.



consignes de sécurité
Signifi cation des icônes et symboles utilisés dans ce 
manuel d’utilisation :

AVERTISSEMENT
Indique un risque de blessure grave, voire mortelle.

ATTENTION

Indique un risque potentiel de blessure ou de dégât 
matériel.

ATTENTION

Pour diminuer les risques d’incendie, d’explosion, de 
décharge électrique ou de blessure lorsque vous utilisez le 
lecteur MP3, respectez les consignes de sécurité suivantes :

REMARQUE
Indique des conseils ou des pages auxquelles se référer 
afi n d’en savoir plus sur le fonctionnement du lecteur.

NE PAS tenter d’effectuer quoi que ce soit.

NE PAS démonter.

NE PAS toucher.

Respecter scrupuleusement les consignes.

Débrancher la fi che de la prise murale.

Appeler le service d’assistance technique pour obtenir de l’aide.

Ces symboles d’avertissement vous indiquent comment éviter de vous 
blesser et de blesser d’autres personnes. 
Veuillez respecter scrupuleusement les consignes. 
Après avoir lu ce chapitre, rangez ce mode d’emploi dans un endroit sûr afi n 
de pouvoir vous y référer ultérieurement.



consignes de sécurité
Ce manuel vous indique comment utiliser correctement votre nouveau
lecteur MP3. Lisez-le attentivement avant toute utilisation afi n d’éviter
d’endommager votre lecteur ou de vous blesser.
Portez particulièrement attention aux avertissements suivants :

PROTEGEZ-VOUS
Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil 
vous-même.

Evitez de mouiller l’appareil ou de le faire tomber dans l’eau. Si une 
telle situation se produit malgré tout, n’allumez pas le lecteur car vous 
risqueriez de vous électrocuter. Contactez plutôt le service clientèle de 
Samsung le plus proche de chez vous.
Ne posez jamais l’appareil à proximité d’objets émettant des ondes 
électromagnétiques.
N'utilisez pas les écouteurs lorsque vous conduisez une bicyclette, une 
automobile ou une moto.
Dans le cas contraire, vous risqueriez de provoquer un accident grave.
L’utilisation des écouteurs en marchant ou lorsque vous courrez, en particulier sur 
les passages piétons, peut se révéler très dangereuse.

Faites particulièrement attention lorsque le câble USB du lecteur n’est 
pas branché et pend dans le vide. 
La fi che USB possède des bords tranchants et risque de vous blesser.

Ne conservez pas l’appareil dans un endroit humide, poussiéreux ou 
couvert de suie ; vous risqueriez de provoquer un incendie ou une 
décharge électrique.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTEGEZ-VOUS
L’utilisation prolongée des écouteurs ou du casque peut fortement réduire 
votre acuité auditive.
Si vous vous exposez à un volume sonore supérieur à 85 dB pendant une durée 
prolongée, votre ouïe sera irrémédiablement endommagée. Plus le son est élevé, plus 
votre acuité auditive diminue (le niveau sonore d’une conversation ordinaire est compris 
entre 50 et 60 dB alors que celui provenant d’une route est d’environ 80 dB). 
Il est fortement recommandé d’utiliser un volume sonore moyen (le volume moyen est 
habituellement inférieur de 2/3 au volume maximal).
Si vous ressentez des bourdonnements dans les oreilles, réduisez le 
volume ou n’utilisez plus les écouteurs ou le casque.

PROTEGEZ VOTRE LECTEUR MP3
Ne laissez pas l’appareil dans un lieu où la température excède 35°C 
(ex. : sauna ou voiture en stationnement).
Evitez tout choc brutal (ex. : chute).
Ne posez pas d’objets lourds sur l’appareil.
Empêchez que des particules externes ou de la poussière ne pénètrent 
dans l’appareil.
Ne posez jamais l’appareil à proximité d’objets émettant des ondes 
électromagnétiques.
Veillez à toujours enregistrer vos données les plus importantes. Samsung 
ne saurait être tenu pour responsable en cas de pertes de données.
Utilisez uniquement les accessoires fournis ou agréés par Samsung.
Evitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil à l’aide 
de produits chimiques (ex. : benzène ou diluant) ; vous risqueriez de provoquer 
un incendie ou une décharge électrique ou d’en détériorer la surface.
Suivez attentivement ces instructions afi n d’éviter de vous blesser ou 
d’endommager le lecteur.
Nous vous conseillons d’imprimer ce mode d’emploi en couleur et de 
paramétrer l’option d’impression « Ajuster à la taille de la page » pour 
qu’il soit plus agréable à lire.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION
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fonctions de base
CONTENU
Votre nouveau lecteur MP3 est fourni avec les accessoires présentés 
ci-dessous. Si l’un de ces éléments ne se trouve pas dans l’emballage, 
contactez le service clientèle de Samsung.

Lecteur Ecouteurs

Câble USB CD d’installation

Il se peut que les accessoires livrés avec votre appareil soient légèrement 
différents de ceux illustrés.
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VOTRE LECTEUR MP3

Interrupteur Alimentation et 
Maintien
Faites glisser dans le sens opposé à 
celui indiqué par la fl èche pour allumer/
éteindre l’appareil.
Faites glisser dans le sens indiqué par 
la fl èche pour verrouiller les touches.

Ecran

Bouton de réinitialisation
Si un dysfonctionnement du lecteur 
survient, appuyez sur le bouton de 

réinitialisation à l’aide d’un objet 
pointu afi n de réinitialiser le système.
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VOTRE LECTEUR MP3 (Suite)
Les boutons suivants sont des touches tactiles.

Bouton de menu
Appuyez légèrement pour affi cher 

l’écran de menu.
Bouton d’augmentation du volume

Appuyez légèrement pour augmenter le volume 
ou accéder à l’élément/au menu précédent.

Bouton de retour en arrière
Appuyez légèrement pour aller à l’écran précédent.
Appuyez longuement sur ce bouton pour accéder à 

l’écran du menu principal.

Bouton d’accès au fi chier précédent
Ce bouton permet de sélectionner la plage/le menu 

précédent(e) ou de lire la plage en cours à partir du début.
Appuyez longuement sur ce bouton pour passer 

rapidement d’une plage à une autre.

Bouton de lecture/pause, sélection 
Appuyez légèrement pour sélectionner la lecture/
pause et la fonction et accéder à l’écran suivant.

Bouton de réduction du volume
Ce bouton permet de diminuer le volume ou 

d’accéder à l’élément/au menu suivant.

Bouton d’accès au fi chier suivant
Ce bouton vous permet d’accéder à la plage/au 

menu suivant(e). 
Appuyez longuement sur ce bouton pour passer 

rapidement d’une plage à une autre.
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VOTRE LECTEUR MP3 (Suite)

Ecouteurs
Pour votre confort, les 
lettres L (écouteur gauche) 
et R (écouteur droit) sont 
gravées sur chaque écouteur. 
Ce cordon sert également 
d’antenne radio.

Prise pour écouteurs

Trou de la cordelette

Port USB

Microphone
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ECRANS
Musique

1 Témoin Bluetooth/verrouillage

2 Témoin du menu associé

3 Etat de la batterie

4
Témoin de lecture de la plage 
en cours/du nombre total de 
plages

5 Indicateur de vitesse de lecture

6 Heure actuelle

7 Durée de lecture totale

8
Affi chage Lecture/Pause et 
Recherche

9 Témoin du mode Musique

10 Témoin du mode Lecture

11 Témoin du mode DNSe

12 Ecran Lect mus.

13 Barre d'état de la lecture

14 Durée de lecture actuelle

15 Titre de la plage

Les représentations à l’écran fi gurent à titre indicatif uniquement. 
L’écran réel de votre appareil peut être différent.REMARQUE

Songs

8

9

10

11

13

14

15

1

3

2

4

5

6

7

12
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ECRANS (Suite)
Vidéo

1
Témoin Bluetooth/
verrouillage 6 Témoin du mode Vidéo

2 Etat de la batterie 7 Nom du fi chier

3 Heure actuelle 8 Barre d'état de la lecture

4 Durée de lecture totale 9 Durée de lecture actuelle

5
Affi chage Lecture/Pause et 
Recherche

Video Track 1

5

6

7

8

9

1

2

4

3
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ECRANS (Suite)
Image

1 Témoin Bluetooth/verrouillage

2 Etat de la batterie

3 Témoin du fi chier en cours/du 
nombre total de fi chiers

4 Heure actuelle

5
Etat de la lecture des fi chiers 
musicaux

6 Témoin du mode Image

7 Témoin du menu associé

8 Nom du fi chier

Radio FM
1 Témoin Bluetooth/verrouillage

2 Etat de la batterie

3 Heure actuelle

4 Témoin du mode Radio

5 Affi chage Manuel/
Présélectionné

6
Affi chage de la fréquence en 
cours (MHz)

Pictures

Picture Image1.jpg

5

6

7

8

1

2

3

4

[Ecran de prévisualisation]

MANUAL

4

5

6

2

3

1
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UTILISATION DES BOUTONS TACTILES
Appuyez légèrement sur l’écran tactile du bout du doigt.

Afi n de ne pas endommager l’écran tactile, utilisez uniquement vos doigts pour 
l’activer.
Veillez toujours à avoir les mains propres avant d’utiliser votre appareil.
N’utilisez jamais le pavé tactile mains gantées.
Il est possible que l’écran ne fonctionne pas si vous utilisez votre ongle ou un autre 
objet tel qu’un stylo à bille.

REMARQUE
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CHARGEMENT DE LA BATTERIE
Chargez-la avant d’utiliser votre lecteur pour la première fois ou lorsque vous 
ne l’avez pas utilisé pendant une période prolongée.
La batterie de votre lecteur MP3 se charge complètement en environ trois 
heures, mais cette durée peut varier en fonction de la confi guration de votre 
ordinateur.

Avant de démarrer- Retirez les écouteurs avant de brancher le câble USB.

1. Branchez l’extrémité la plus large du câble USB sur le port de connexion 
USB situé dans la partie inférieure du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.

Affi chage à l’écran
USB connecté
Chargement en cours…
Chargement terminé

2
1
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ENTRETIEN DE LA BATTERIE
La batterie durera plus longtemps si vous respectez ces consignes d’entretien 
et de rangement.
• Rechargez et rangez l’appareil dans un lieu où la température est comprise 

entre 5°C et 35°C.
• Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger 

la batterie à des fréquences trop rapprochées peut réduire sa durée de vie. 
• Comme pour tout autre produit de consommation, la durée de vie de la 

batterie raccourcit progressivement avec le temps.
Si vous rechargez le lecteur via un ordinateur portable, assurez-vous que la batterie du 
portable est entièrement chargée ou que l’ordinateur est lui-même relié à une prise secteur.

MISE SOUS ET HORS TENSION DE L’APPAREIL
Mise sous tension de l’appareil
Faites glisser l’interrupteur  dans le sens 
opposé à celui indiqué par la fl èche.

L’appareil s’allume.

Mise hors tension de l’appareil
Faites à nouveau glisser l’interrupteur  dans 
le sens opposé à celui indiqué par la fl èche.

L’appareil s’éteint.

L’appareil s’éteint automatiquement lorsque aucun des boutons n’est actionné 
pendant une durée prédéfi nie en mode Pause (Pause). La durée par défaut de 
<Auto Power Off> (Extinction auto) est de 1 minute, mais vous pouvez la modifi er. 
Consultez la page 31 pour plus d’informations.

REMARQUE

REMARQUE
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LECTURE DE MUSIQUE
Chargez des fi chiers musicaux sur votre nouveau lecteur MP3 à l’aide de 
Samsung Media Studio. Pour en savoir plus sur Samsung Media Studio, 
consultez la page 36.
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2.  Appuyez légèrement sur [ ] pour sélectionner <Music>

(Musique), puis sur [ ].
3. Appuyez sur [ ] et [ ] pour sélectionner le fi chier 

musical de votre choix.
4. Appuyez légèrement sur [ ].

La lecture du fi chier musical démarre.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

CONTROLE DU VOLUME
Appuyez légèrement sur [ ].

L’icône du contrôle de volume s’affi che.
La plage de réglage du volume est comprise entre 0 et 30.

Appuyez légèrement sur [ ] pour augmenter le volume ou sur 
   [ ] pour le diminuer.

REMARQUE

Music

Music
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VERROUILLAGE DES BOUTONS
La fonction Verrouillage permet de verrouiller tous les boutons du lecteur MP3 ;
ainsi, si vous appuyez sur une touche par mégarde lors de la lecture d’un 
fi chier, celle-ci ne sera pas interrompue.
1. Faites glisser l’interrupteur dans le sens de 

la fl èche.
2. Faites glisser l’interrupteur dans le sens 

opposé à celui indiqué par la fl èche pour désactiver la 
fonction de verrouillage.

RECHERCHE DE FICHIERS A L’AIDE DU 
« DOSSIER NAVIGATEUR »
Recherchez des fi chiers en toute simplicité grâce la fonction <File Browser>
(Dossier Navigateur).
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner <File

Browser> (Dossier Navigateu), puis sur [ ].
Le dossier <File Browser> (Dossier Navigateur) contenant des   
fi chiers musicaux, des listes de lecture, des vidéos, des images, des  

 listes de diffusion, des textes, des jeux, des fi chiers enregistrés et   
 des fi chiers reçus apparaît.

3. Appuyez légèrement sur [ ] pour sélectionner le 
dossier souhaité.

4. Appuyez légèrement sur [ ] pour affi cher la liste des fi chiers dans le dossier 
sélectionné.

Appuyez légèrement sur [ ] pour aller à l’écran précédent.
5. Appuyez légèrement sur [ ] pour sélectionner le fi chier souhaité.
6.  Appuyez légèrement sur [ ].

La lecture du fi chier démarre.

Music
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SUPRESSION DE FICHIERS A L'AIDE DU « DOSSIER 
NAVIGATEUR »
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner <File

Browser> (Dossier Navigateu), puis sur [ ].
Le contenu de la liste des dossiers <File Browser> (Dossier 
Navigateur) apparaît.

3. Appuyez légèrement sur [ ] pour sélectionner le 
dossier souhaité, puis sur [ ].

4. Appuyez légèrement sur [ ] pour sélectionner le fi chier que vous 
souhaitez supprimer, puis sur [ ].

5. Appuyez légèrement sur [ ] pour sélectionner <Delete> (Supprimer), puis 
sur [ ].

Une fenêtre de confi rmation apparaît.

6.  Appuyez légèrement sur [ ] pour sélectionner <Yes> (Oui), puis sur [ ].
Le fi chier sélectionné est supprimé.

Une fois supprimés, les fi chiers ne peuvent plus être récupérés

File Browser

Music
Playlists
Video
Pictures
Datacasts
Texts
Games
Recorded Files
Received Files

ATTENTION
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MODIFICATION DES REGLAGES ET DES PREFERENCES
Votre lecteur MP3 comprend des réglages et des préférences défi nis par défaut, 
mais vous pouvez les modifi er selon votre goût afi n de personnaliser votre lecteur.

Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

Réglages du style du menu
Vous pouvez modifi er l’aspect et la police du menu et supprimer l’image 
de fond d’écran du menu principal.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Menu Style> (Style du menu), puis sur [ ].

Le menu <Menu Style> (Style du menu) s’affi che.

4. Les boutons [ ] et [ ] servent à régler des fonctions.
Appuyez légèrement sur [ ] pour passer à l’élément suivant/sélectionner le menu.
Appuyez légèrement sur [ ] pour monter ou descendre dans le menu actuel.

Options de réglage du style du menu 
Menu Design (Aspect du menu) : Vous pouvez modifi er le style de l’écran du menu principal. 
Choisissez entre <Sammy> (Sammy), <Pendant> (Pendentif) et <My Skin> (Mon habillage).
Color Tone (Couleur) : Vous pouvez modifi er la couleur du menu et du fond d’écran. 
Si vous réglez <Sammy> dans <Menu Design> (Aspect du menu), <Color Tone> 
(Couleur) est désactivé.
Font (Police) : Vous pouvez modifi er le type de police du menu. 3 types de police sont 
proposés. Il est possible que pour certaines langues de menu, l’option <Font> (Police) 
ne s’affi che pas.
Reset My Skin (Réinitialiser mon habillage) : Permet d’initialiser l’image de fond 
de l’écran tactile par l’image par défaut. Si vous réglez <Sammy> ou <Pendant> 
(Pendentif) dans <Menu Design> (Aspect du menu), <Reset My Skin> (Réinitialiser 
mon habillage) est désactivé.

REMARQUE

Menu Style
Sound
Display
Library Update
Language
Date & Time
System

Settings
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages du son
Vous pouvez régler l’égaliseur principal, le signal sonore et l’intensité du 
volume sonore.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Sound> (Son), puis sur [ ].

Le menu <Sound> (Son) s’affi che.

4. Les boutons [ ] et [ ] servent à régler des fonctions.

Options de réglage du son 
Master EQ (EG princ.) : Vous pouvez optimiser les réglages du son. 
Appuyez légèrement sur [ ] pour sélectionner la fréquence que vous 
souhaitez paramétrer. Appuyez légèrement sur [ ] pour régler le niveau de 
la fréquence sélectionnée, puis sur [ ].
Beep Sound (Signal sonore) : Permet d’activer ou de désactiver l’émission d’un 
signal sonore lors des opérations effectuées sur l'écran tactile.
Choisissez entre <Off> (Arrêt) et <On> (Marche). Pendant la lecture musicale, 
le signal sonore est désactivé même si l’option est réglée sur <On> (Marche).
Volume Limit (Limitation du volume) : Vous pouvez éviter l’apparition de troubles 
auditifs en réglant l’intensité du volume sonore lors de l’utilisation des écouteurs. 
l’option <On> (Marche) fi xe le niveau maximal du volume à 15. Le niveau 
maximal du volume lorsque la limite est réglée sur <Off> (Arrêt) est de 30. Même 
si vous avez sélectionné <Off> (Arrêt), le volume reviendra au niveau 15 lorsque 
vous rallumerez le lecteur afi n de vous éviter toute lésion du système auditif.

Settings

Menu Style
Sound
Display
Library Update
Language
Date & Time
System



fonctions de base _ 25

MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de l’affi chage
Modifi ez le temps de mise en veille de l’affi chage et la luminosité de 
votre écran.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Display> (Affi cher), puis sur [ ].

Le menu <Display> (Affi cher) s’affi che.

4. Les boutons [ ] et [ ] servent à régler des 
fonctions.

Options de réglage de l’affi chage
Display Off (Affi ch. Désactivé) : Si aucun nombre n’est entré pour la sélection 
de la période, l’écran s’éteint automatiquement. Vous pouvez choisir entre 
<15 sec>, <30 sec>, <1 min>, <3 min>, <5 min>, et <Always On> (Toujours 
activé). Pour rallumer l’écran, il vous suffi t d’appuyer sur n’importe quel bouton. 
Brightness (Luminosité) : Permet de régler la luminosité de l’écran d’affi chage. 
Sélectionnez un niveau <0-10>, où 10 est le plus lumineux.

Settings

Menu Style
Sound
Display
Library Update
Language
Date & Time
System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages pour mettre à jour la bibliothèque
Veillez à mettre à jour votre bibliothèque après avoir transféré le fi chier 
sur le disque amovible.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Library Update> (Mise à jour de la [Base de 
données] de la Bibliothèque), puis sur [ ].

Le menu <Library Update> (Mise à jour de la [Base de 
données] de la Bibliothèque) s’affi che.

4. Appuyez légèrement sur [ ] pour sélectionner la langue de votre 
choix, puis sur [ ].

Options de mise à jour de la bibliothèque
Manual Update (Mise à jour manuelle) : Si vous avez réglé la mise à jour 
automatique sur <Off> (Arrêt), les fi chiers musicaux avec étiquette ID3 doivent 
être mis à jour manuellement afi n que leurs caractéristiques (ex. : nom de 
l’artiste, nom de l’album et genre musical) puissent s’affi cher dans le menu 
Musique.
Auto Update (Mise à jour automatique) : Si vous avez activé l’option <Auto 
Update> (Mise à jour automatique) avant de transférer le fi chier sur le disque 
amovible, le fi chier peut être automatiquement mis à jour sur le lecteur. En 
sélectionnant <On> (Marche), la bibliothèque est automatiquement mise à jour 
dès que le câble USB est débranché.

Settings

Menu Style
Sound
Display
Library Update
Language
Date & Time
System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de la langue
De nombreuses langues sont disponibles pour l’affi chage des menus 
de votre nouveau lecteur MP3. Vous pouvez changer facilement de 
préférence de langue.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Language> (Langue), puis sur [ ].

4. Appuyez légèrement sur [ ] pour sélectionner 
la langue de votre choix, puis sur [ ].

Settings

Menu Style
Sound
Display
Library Update
Language
Date & Time
System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Options de réglage de la langue

Menu : Permet de régler la langue du menu. Options disponibles <English>, 
<한국어>, <Français>, <Deutsch>, <Italiano>, <日本語>, < >,
< >, <Español>, < >, <Magyar>, <Nederlands>, <Polski>, 
<Português>, <Svenska>, < >, < eština>, < >, <Türkçe>, 
<Norsk>, <Dansk>, <Suomi>, <Español (Sudamérica)>, <Português 
(Brasil)>, <Indonesia>, <Ti ng Vi t>, <Bulgarian>, <Român >, < >,
<Slovenš ina> et <Slovenský>.
ID3 Tag : Vous permet de régler la langue dans laquelle les informations de 
suivi seront affi chées. Options disponibles <English>, <Korean>, <French>,
<German>, <Italian>, <Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>,
<Russian>, <Hungarian>, <Dutch>, <Polish>, <Portuguese>, <Swedish>,
<Thai>, <Finnish>, <Danish>, <Norwegian>, <Farsi>, <Afrikaans>, <Basque>,
<Catalan>, <Czech>, <Estonian>, <Greek>, <Hrvatski>, <Icelandic>,
<Rumanian>, <Slovak>, <Slovene>, <Turkish> et <Vietnamese>.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
Qu’est-ce que l’étiquette ID3?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations 
relatives au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et 
un champ commentaire.

REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglage de la date et de l’heure
Vous pouvez régler la date et l’heure actuelles.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Date&Time> (Date et heure), puis sur [ ].

Le menu <Date&Time> (Date et heure) s’affi che.

4. Appuyez légèrement sur [ ] pour accéder à <Year, Month, Date, 
Hour, Min, AM/PM> (Année, Mois, Heure, Minute, AM/PM) et 
appuyez sur [ ] pour régler chaque élément.

5. Appuyez légèrement sur [ ].
6. Appuyez légèrement sur [ ] pour sélectionner <Yes> (Oui), puis 

sur [ ].
Le réglage de l’heure est terminé.

Menu Style
Sound
Display
Library Update
Language
Date & Time
System

Settings
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages du système
Sélectionnez le mode Veille, Début, Extinction auto ou Réglage par 
défaut adapté.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<System> (Système), puis sur [ ].

Le menu <System> (Système) s’affi che.

4. Les boutons [ ] et [ ] servent à régler des fonctions. 

Menu Style
Sound
Display
Library Update
Language
Date & Time
System

Settings
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Options de réglage du système

My Profi le (Mon profi l) : Permet de saisir votre nom et votre date de naissance. 
Reportez-vous à la page 32. 
Sleep (Veille) : Permet d’éteindre automatiquement l’appareil après l’écoulement de 
la durée préréglée. Options disponibles : <Off> (Arrêt), <15min>, <30min>, <60min>, 
<90min> ou <120min>.
Start Mode (Mode Début) : Permet de défi nir l’écran de démarrage affi ché lors de la mise 
sous tension du lecteur. Choisissez entre <Main Menu> (Menu Principal) et <Last State> 
(Dernier état). Sélectionnez <Main Menu> (Menu Principal) pour démarrer le système avec 
l’écran du menu principal et <Last State> (Dernier état) pour affi cher l’écran du dernier 
menu utilisé.
Auto Power Off  (Extinction auto) : Permet d’éteindre automatiquement l’appareil lorsque 
aucun bouton n’est actionné avant l’écoulement de la durée prédéfi nie en mode Pause. 
choisissez entre <15sec>, <30sec>, <1min>, <3min>, <5min> et <Always On> (Toujours 
allumé).
Default Set (Réglage par défaut) : Permet de revenir aux valeurs de réglage par défaut. 
Options disponibles : <Yes> (Oui) ou <No> (Non). <Yes> (Oui) vous permet de réinitialiser 
l’appareil sur les réglages par défaut. <No> (Non) permet d’annuler les réglages par défaut.
Format (Formater) : Vous permet de formater la mémoire interne. Options disponibles : 
<Yes> (Oui) ou <No> (Non). 
Le réglage sur <Yes> (Oui) formate la mémoire interne et supprime tous les fi chiers du 
lecteur. En revanche, <No> (Non) ne lance pas le formatage de la mémoire interne. vérifi ez 
avant de lancer le formatage.
About (A propos de) : Appuyez sur [ ] pour consulter les informations relatives à la 
version du micrologiciel, à la capacité de la mémoire et au numéro de fi chier.
<Firmware Version> (Version du fi rmware) affi che la version actuelle du micrologiciel. 
<Memory> (Mémoire) - <Used> (Utilisé) indique la mémoire actuellement utilisée, 
<Available> (Disponible) indique la capacité restante de la mémoire et <Total> (Total) 
indique la capacité totale de la mémoire.
<Files> (Fichiers) : Permet de vérifi er le nombre de fi chiers musicaux, de vidéos, d’images, 
de textes ainsi que le nombre total de fi chiers.

A propos de la mémoire intégrée
1 Go=1,000,000,000 octets : la capacité réelle formatée peut être 
inférieure, car le micrologiciel interne en utilise une partie.

REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages Mon nom

1. Appuyez légèrement sur [ ] pour sélectionner 
<My Profi le> (Mon profi l), puis sur [ ].

2. Appuyez légèrement sur [ ] pour sélectionner 
<My Name> (Mon nom), puis sur [ ].

La fenêtre Renommer Mon nom apparaît.
3. Utilisez les boutons [ ] et [ ] pour 

renommer le périphérique.
[ ] : Le mode de saisie passe de Lettres majuscules 

à Lettres minuscules et à Chiffre.
[ ] : Permet de supprimer les caractères l’un après 

l’autre.
[ ] : Confi rmez votre modifi cation.
Lorsque le réglage du nom est terminé, votre nom s'affi che lorsque vous 
allumez ou éteignez le lecteur.

Réglages Mon anniversaire
Avant de démarrer - Réglez tout d’abord l’horloge sur l’heure actuelle. 

Reportez-vous à la page 29.

1. Appuyez légèrement sur [ ] pour sélectionner 
<My Profi le> (Mon profi l), puis sur [ ].

2. Appuyez légèrement sur [ ] pour sélectionner 
<My Birthday> (Mon anniv.), puis sur [ ].

La fenêtre Éditer Mon anniversaire apparaît.
3. Appuyez légèrement sur [ ] pour accéder à 

<Year, Month, Date> (An, Mois, Jour) et appuyez 
sur [ ] pour régler chaque élément.

4. Appuyez légèrement sur [ ].
Lorsque les réglages de la date de naissance sont 
terminés, votre anniversaire vous est rappelé lors de la mise sous tension 
du lecteur.

Rename My Name

YP-T10_

Edit My Birthday
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REINITIALISATION DU SYSTEME
Si votre lecteur MP3 ne s’allume pas, ne lance pas de lecture de fi chier ou n’est 
pas reconnu par votre ordinateur lorsque vous le branchez, il est préférable de 
réinitialiser le système.

Appuyez sur le bouton de réinitialisation 
situé sur la partie inférieure de l'appareil à 
l'aide d'un objet pointu, comme une agrafe.

Le système est réinitialisé.
La fonction Reset (Réinitialisation) ne permet 
pas de supprimer les renseignements de durée 
et les données enregistrées dans la mémoire 
intégrée.
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samsung media studio
L’application logicielle Samsung Media Studio est facile à utiliser et 
vous permet de classer vos fi chiers sur votre ordinateur. Une fois vos 
fi chiers classés et organisés dans Samsung Media Studio, vous pouvez 
les transférer rapidement vers votre lecteur MP3 sans avoir à faire des 
recherches sur l’ensemble de votre disque dur pour retrouver le bon 
fi chier.

CONFIGURATION REQUISE
Votre ordinateur doit être conforme aux spécifi cations minimales suivantes pour 
que vous puissiez installer et exécuter Samsung Media Studio :
• Pentium 500 MHz ou plus
• Port USB 2.0
• Windows 2000/XP/Vista
• DirectX 9.0 ou version ultérieure
• 100 Mo d’espace libre sur le disque dur
• Lecteur de CD-Rom (2X ou plus)
• Windows Media Player 9,0 ou ultérieur
• Résolution 1024 X 768 ou plus
• Internet Explorer 6.0 ou version ultérieure
• Mémoire vive 512 Mo ou plus
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INSTALLATION DE SAMSUNG MEDIA STUDIO
Assurez-vous que le programme d’installation de Samsung Media Studio a été 
lancé sur le compte administrateur de votre ordinateur. 
Dans le cas contraire, <Samsung Media Studio> ne pourra pas être installé. Pour 
trouver le compte administrateur, veuillez vous référer au manuel d’utilisation de 
votre ordinateur.

1. Insérez le CD d’installation fourni avec le 
lecteur MP3 dans le lecteur CD-ROM de 
votre ordinateur.

2. Cliquez sur <Install now> (Installer 
maintenant).

Suivez les instructions pour démarrer l’installation.

L’installation de <Samsung Media Studio> démarre et une icône s’affi che sur votre 
Bureau lorsque celle-ci est terminée.

N’effectuez pas de mouvements brusques lorsque vous utilisez un CD-ROM installé à  
 la verticale pour le chargement/le retrait du CD d’installation.ATTENTION

ATTENTION
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TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
SAMSUNG MEDIA STUDIO
<Samsung Media Studio> vous permet de sélectionner et de classer des 
fi chiers et des dossiers avant de les transférer vers votre lecteur. Ainsi, le 
balayage des fi chiers sur votre lecteur MP3 devient plus facile et plus rapide. 
Le programme <Samsung Media Studio> est le moyen le plus simple de 
transmettre des fi chiers d’un ordinateur vers votre lecteur MP3.

Avant de démarrer- Retirez les écouteurs avant de brancher le câble USB.

1. Branchez l’extrémité la plus large du câble USB sur le port de connexion USB 
situé dans la partie inférieure du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.
Le message <USB connected> (USB connecté) s'affi che sur l'écran tactile du lecteur.
<Samsung Media Studio> démarre automatiquement lorsque vous branchez le lecteur sur votre 
ordinateur.
Si le programme ne démarre pas automatiquement, double-cliquez sur l’icône 
<Samsung Media Studio> située sur le Bureau.

La technologie de reconnaissance musicale et les données relatives sont fournies par 
Gracenote et Gracenote CDDB®  Music Recognition ServiceSM.
CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, le 
logo et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» sont des 
marques déposées de Gracenote. Music Recognition Service et MRS sont des marques 
de service de Gracenote.

1
2

REMARQUE
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TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
SAMSUNG MEDIA STUDIO (Suite)
3. Cliquez sur l’icône correspondant au type de 

fi chier que vous souhaitez transférer.
Cliquez sur   pour affi cher la liste des fi chiers

   musicaux.

Cliquez sur  pour affi cher la liste des
fi chiers vidéo.

Cliquez sur  pour affi cher la liste des fi chiers
   image.

Cliquez sur  pour affi cher la liste des fi chiers 
etc. La liste des fi chiers ETC comprend des 
types de fi chiers (ex : TXT, etc) autres que les fi chiers 
musicaux, image et vidéo.

4. Cliquez sur <Add File> (Ajouter un fi chier) au bas 
de l’écran de <Samsung Media Studio>.

La fenêtre Open (Ouvrir) apparaît.

5. Sélectionnez les fi chiers que vous souhaitez 
ajouter et cliquez sur <Open> (Ouvrir). 

Les fi chiers sont ajoutés sur la liste située sur la 
partie gauche de l’écran de <Samsung Media 
Studio>.

6. Dans la liste située à gauche, sélectionnez le 
fi chier à transférer.

7. Cliquez sur l’icône  .
Le fi chier sélectionné est transféré vers le lecteur.

5

3

4

7

6
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TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
SAMSUNG MEDIA STUDIO (Suite)

Ne débranchez jamais le câble USB durant le transfert de fi chiers ; vous risqueriez 
d’endommager le lecteur ou l’ordinateur.
Branchez le lecteur directement sur l’ordinateur plutôt que sur un Hub USB afi n 
d’éviter une mauvaise connexion.

Avant le transfert d’un fi chier vidéo vers le lecteur à l'aide du logiciel <Samsung 
Media Studio>, le fi chier est tout d’abord converti automatiquement au format SVI. 
La taille du fi chier est également réglée automatiquement. 
Avant le transfert d’un fi chier image vers le lecteur à l'aide du logiciel <Samsung 
Media Studio>, celui-ci est tout d’abord converti automatiquement au format JPG. 
La taille du fi chier est également réglée automatiquement.
Un fi chier image transféré vers le lecteur sans <Samsung Media Studio> peut être 
différent de l’image originale lors de son affi chage à l'écran.
Toutes les fonctions sont désactivées durant le branchement.
Si vous branchez le câble USB sur l’ordinateur alors que la batterie est faible, il 
faudra quelques minutes au lecteur pour se connecter à l’ordinateur.
Samsung Media Studio met à votre disposition une fonction Aide très complète. 
Si vous ne trouvez toujours pas de réponse à votre question concernant Samsung 
Media Studio, cliquez sur <MENU> --> <Aide> en haut du programme 
<Samsung Media Studio>.
Qu'est-ce que la fonctionnalité SVI?
L'entrelacement Samsung Audio Video (SVI) est un nouveau format vidéo 
développé et contrôlé par Samsung.

ATTENTION

REMARQUE
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UTILISATION DU LECTEUR EN TANT QUE DISQUE 
AMOVIBLE
Vous pouvez utiliser le lecteur comme appareil de stockage de données 
amovible.

Avant de démarrer - Branchez le lecteur sur l’ordinateur.

1. Ouvrez les fi chiers/dossiers à transférer à 
partir de l’ordinateur.

2. Ouvrez <My Computer> (Poste de 
travail) <T10> depuis le bureau.

3. Sélectionnez les fi chiers/dossiers que 
vous souhaitez transférer depuis votre 
ordinateur et faites un cliquer-glisser vers 
le dossier de votre choix dans <T10>.

Les dossiers ou fi chiers sélectionnés sont 
transférés vers le lecteur.

Le message de transfert du fi chier apparaît durant son téléchargement.
Débrancher le câble USB tant que le message est affi ché peut entraîner un 
dysfonctionnement de l’appareil.
L’ordre dans lequel les fi chiers musicaux s’affi chent sur votre PC peut être différent 
de l’ordre de lecture de l’appareil.
Si vous transférez un fi chier DRM (fi chier chargé) vers le disque amovible, le fi chier 
ne sera pas lu.

Les fi chiers vidéo doivent être transférés sur le lecteur à l’aide de <Media Studio> 
(Media Studio).
Qu’est-ce que DRM?
La technologie et le service DRM (Gestion des droits numériques) permettent 
d’éviter l’utilisation illégale de données numériques et de protéger les détenteurs de 
droits d’auteur. Les fi chiers DRM sont des fi chiers musicaux chargés pour lesquels 
s’applique la technologie de protection concernant les copies illégales de fi chiers 
musicaux MP3 obtenus de façon légale.

ATTENTION

REMARQUE
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DÉBRANCHER L’APPAREIL DE L’ORDINATEUR
Suivez les étapes ci-dessous pour éviter d’endommager le lecteur et les données au 
moment du débranchement.

1. Positionnez le curseur de la souris sur 
l’icône  située sur la barre des tâches 
en bas à droite du bureau et cliquez sur le 
bouton gauche de la souris.

2. Cliquez sur le message <Safely remove 
USB Mass Storage Device Drive> (Retirer 
en toute sécurité le lecteur USB grande 
capacité).

3. Débranchez le lecteur de l’ordinateur.

Ne débranchez pas le lecteur de l’ordinateur durant le transfert du fi chier. 
Les données ou le lecteur risqueraient d’être endommagés.
Vous ne pouvez pas retirer le lecteur pendant que des fi chiers contenus dans le 
lecteur sont lus sur l’ordinateur. Veuillez réessayer une fois la lecture terminée.
Si vous avez déconnecté le PC de votre lecteur et que vous souhaitez les 
reconnecter, veillez à éteindre le lecteur au préalable.

ATTENTION

2

1
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lecture de fi chiers musicaux
Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

LECTURE PAR CATEGORIE
1. Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner <Music>

(Musique), puis sur [ ].
La liste <Music> (Musique) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner la liste de 
votre choix, puis sur [ ].

Le fi chier musical s’affi che.
4. Appuyez légèrement sur [ ] pour sélectionner le fi chier 

que vous souhaitez lire, puis sur [ ].
La lecture du fi chier musical démarre.

Liste de fi chiers musicaux
Les informations sur le fi chier comprenant le nom de l’artiste, le nom de l’album, le titre de la plage et le 
genre s’affi chent en fonction des informations fi gurant sur l’étiquette ID3 du fi chier musical correspondant. 
Un fi chier sans étiquette ID3 s’affi che comme [Unknown] (inconnu).
Now Playing (En lecture) : Permet de lire le fi chier lu en dernier ou d’affi cher l'écran de lecture du fi chier en cours.
Artists (Artiste) : Lecture par artiste Albums (Albums) : Lecture par album
Songs (Chansons)  : Lecture en ordre numérique ou alphabétique
Genres (Genres) : Lecture par genre Playlists (Listes de lecture) : Lecture par liste
Recorded Files (Fichiers enregistrés) : Affi che tous les fi chiers enregistrés.
Music Browser (Navig. musique) : Permet d’affi cher tous les fi chiers musicaux enregistrés dans le dossier musical.

Les fi chiers musicaux aux formats MP3, WMA, Ogg et AAC sont compatibles avec ce lecteur.
Les fi chiers MP1 ou MP2 possédant uniquement une extension modifi ée vers MP3 
peuvent ne pas être lus.
Qu’est-ce que l’étiquette ID3?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives au 
fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ commentaire.

REMARQUE

REMARQUE

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Music



42 _ lecture de fi chiers musicaux

PAUSE
1. Appuyez légèrement sur [ ] lorsque la lecture de la musique est en cours.

La lecture de la musique est interrompue.

2. Appuyez à nouveau sur [ ].
La lecture reprend à l’endroit où vous l’avez suspendue.

RECHERCHE A L’INTERIEUR D’UNE PLAGE
1. Appuyez longuement sur [ ] pendant que la plage sélectionnée est en 

cours de lecture.
Ces boutons permettent d’effectuer la recherche vers le début ou la fi n de la plage.

2. Relâchez le bouton dès que vous souhaitez reprendre la lecture.
La lecture commence dès que vous relâchez le bouton.

LECTURE DE LA PLAGE EN COURS A PARTIR DU DEBUT
1. Appuyez légèrement sur [ ] après 3 secondes de lecture.

La plage en cours est lue à partir du début.

LECTURE DE LA PLAGE PRECEDENTE
Appuyez légèrement sur [ ] dans les 3 premières secondes de lecture.
Appuyez deux fois sur [ ] après 3 secondes de lecture.

La lecture de la plage précédente démarre.

LECTURE DE LA PLAGE SUIVANTE
Appuyez légèrement sur [ ].

La lecture de la plage suivante démarre.
Pour un fi chier VBR, le fi chier musical précédent ne peut pas être lu même si vous 
appuyez sur [ ] dans les 3 premières secondes de lecture.ATTENTION
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CREATION D’UNE PLAYLIST 
A L’AIDE DE SAMSUNG MEDIA STUDIO
Grâce à <Samsung Media Studio>, vous pouvez créer votre propre playlist.

Avant de démarrer -  Branchez le lecteur MP3 sur l’ordinateur.
Samsung Media Studio doit être installé sur l’ordinateur.

Création d’une playlist

1. Cliquez sur le bouton <Playlists> en haut de Samsung Media 
Studio.

La fenêtre Playlists apparaît.

2. Cliquez sur le bouton <Nouv. Playlist> au bas de l’écran.
La fenêtre Créer listes de lecture apparaît.

3. Tapez le titre de la playlist et cliquez sur <OK>.
Lors de la création d’une nouvelle Playlist, celle-ci sera enregistrée dans la 
section <Playlists> de Samsung Media Studio.

2

1

OK 3
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CREATION D’UNE CREATION D’UNE PLAYLIST 
A L’AIDE DE SAMSUNG MEDIA STUDIO SUR VOTRE 
LECTEUR MP3 (Suite)

Ajout de fi chiers musicaux à une playlist que vous avez créé

1. Cliquez sur le bouton <Bibliothèque> en haut de Samsung Media Studio.
La fenêtre <Bibliothèque> apparaît.

2. Cliquez sur le bouton <Playlists> dans le coin droit de la fenêtre.
La fenêtre Playlists apparaît.

3. Double-cliquez sur une playlist dans la fenêtre de droite.
4. Sélectionnez les fi chiers que vous souhaitez transférer dans la 

fenêtre <Bibliothèque>.
5. Cliquez sur l’icône .

Les fi chiers sélectionnés sont ajoutés à la playlist. 

5

1

3

4 2



lecture de fi chiers musicaux _ 45

CREATION D’UNE PLAYLIST SUR VOTRE LECTEUR 
MP3 (Suite)

Transfert d’une playlist vers le lecteur avec Samsung 
Media Studio

1. Cliquez sur le bouton <Playlists> en haut de Samsung Media Studio.
La fenêtre <Playlists> apparaît.

2. Sélectionnez une playlist dans la fenêtre <Playlists>.
3. Cliquez sur l’icône .

La playlist sélectionnée sera transférée vers le dossier du lecteur en passant 
par le navigateur <File Browser> (Dossier Navigateur>  <Playlists> (Listes de 
lecture).

Le lecteur peut lire jusqu’à 400 listes de lecture et jusqu'à 400 fi chiers 
musicaux pour chaque listes de lecture.

1

32

REMARQUE
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3
Si vous avez déjà téléchargé des fi chiers sur votre lecteur MP3, vous pouvez 
créer une liste de lecture « Favoris » sans Samsung Media Studio ou votre 
ordinateur.
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<File Browser> (Dossier Navigateu), puis sur [ ].
3. Appuyez légèrement sur [ ] pour sélectionner <Music>

(Musique), puis sur [ ].
La liste des fi chiers musicaux s'affi che.

4. Appuyez légèrement sur [ ] pour sélectionner un fi chier 
à ajouter à la liste des favoris, puis sur [ ].

Le menu de la liste de lecture apparaît.

5. Appuyez légèrement sur [ ] pour sélectionner 
<Add to Playlist> (Aj. à liste lect.), puis sur [ ].

<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) apparaît.

6. Appuyez légèrement sur [ ] pour sélectionner un 
numéro de liste de lecture à ajouter au fi chier sélectionné, 
puis sur [ ].

Le fi chier sélectionné est ajouté à la liste de lecture.
Vérifi ez la liste de lecture dans <Music> (Musique)  <Playlists> (Listes de lecture) 
<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) dans le menu principal.

Vous pouvez ajouter jusqu’à 200 fi chiers musicaux dans chaque liste de lecture 
(<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5)).REMARQUE

Add to Playlist
Delete

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5
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LECTURE D’UNE LISTE DE LECTURE
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner <Music>

(Musique), puis sur [ ].
La liste musicale s'affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Playlists> (Listes de lecture), puis sur [ ].

La/Les liste(s) de lecture s'affi che(nt).

4. Appuyez légèrement sur [ ] pour sélectionner la liste 
de lecture de votre choix, puis sur [ ].

Les fi chiers musicaux enregistrés dans la liste de lecture 
sélectionnée apparaissent.
Si vous ne trouvez aucune liste de lecture, le message 
<No fi le.> (Aucun fi chier.) s’affi che à l’écran.

5. Appuyez légèrement sur [ ] pour sélectionner le fi chier 
musical que vous souhaitez lire, puis sur [ ].

La lecture du fi chier musical démarre.

Reportez-vous aux pages 43 et 45 pour en savoir plus sur le transfert de la liste de 
lecture avec <Samsung Media Studio>.REMARQUE

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Music

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5

Playlists
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SUPPRESSION D’UN FICHIER DE LA LISTE DE LECTURE
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner <Music>

(Musique), puis sur [ ].
La liste musicale s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Playlists> (Listes de lecture), puis sur [ ].

La/Les liste(s) de lecture s'affi che(nt).

4. Appuyez légèrement sur [ ] pour sélectionner la liste 
de lecture de votre choix, puis sur [ ].

Les fi chiers musicaux enregistrés dans la liste de lecture sélectionnée apparaissent.

5. Appuyez légèrement sur [ ] pour sélectionner un fi chier à supprimer de la 
liste de lecture, puis sur [ ].

Le menu de la liste de lecture apparaît.

6. Appuyez légèrement sur [ ] pour sélectionner <Delete from Playlist>
(Suppr. de liste lect.), puis sur [ ].

Le fi chier sélectionné est supprimé de la liste de lecture.
Le fi chier sélectionné dans la liste de lecture ne peut pas être supprimé en cours de lecture.

SUPPRESSION DE TOUS LES FICHIERS DE LA LISTE DE LECTURE
Suivez les étapes 1 à 4 ci-dessus.
5. Appuyez légèrement sur [ ].

Le menu de la liste de lecture apparaît.

6. Appuyez légèrement sur [ ] pour sélectionner <Delete
All from Playlist> (Suppr. tt de liste lect.), puis sur [ ].

Tous les fi chiers sont supprimés de la liste de lecture.

REMARQUE

Delete from Playlist
Delete All from Playlist

Delete from Playlist
Delete All from Playlist
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UTILISATION DU MENU MUSIQUE
Le menu Musique vous permet de gérer toutes les facettes de l’écoute (de la 
sélection des plages et des playlists au choix du fond d’écran durant l'écoute).

Régler l’effet sonore
Profi tez d’une qualité de son plus nette.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Sound Effect> (Effets Sonores), puis sur [ ].

Le menu <Sound Effect> (Effets Sonores) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
l’effet sonore souhaité, puis sur [ ].

Options d’effet sonore
Street Mode (Mode Rue) : Permet d’écouter clairement en extérieur grâce 
au fi ltrage de certains bruits de la rue. Sélectionnez <On> (Marche) ou <Off > 
(Arrêt).
Clarity (Netteté) : Vous bénéfi ciez d’un son plus clair et de meilleure qualité. 
Sélectionnez de <0-2>.

Pour quitter le menu, appuyez légèrement sur [ ].

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Connect to Headset

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe)
Vous permet de choisir le type de son convenant le mieux à chaque 
genre musical.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<DNSe> (DNSe), puis sur [ ].

Le menu <DNSe> s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
le DNSe de votre choix, puis sur [ ].

Choisissez entre <Normal>, <Studio>, <Rock>, 
<Classical> (Classique), <Jazz>, <Ballad> (Ballade), <Club>, <Rhythm & 
Blues> (R&B), <Dance> (Danse), <Concert Hall> (Salle Concert)  et  <User> 
(Utilisateur).
Vous pouvez régler <EQ> (EG) et <3D & BASS> lorsque <User> 
(Utilisateur) est sélectionné. 

Qu’est-ce que la fonctionnalité DNSe?
La technologie Digital Natural Sound Engine (DNSe) est une fonction 
d’optimisation sonore conçue par Samsung pour les lecteurs MP3. Cette 
option offre différents réglages sonores visant à améliorer le type de 
musique que vous écoutez.

REMARQUE

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Connect to Headset
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe) (Suite)
<EQ> (EG)
Vous pouvez paramétrer les fréquences sonores individuellement selon vos 
préférences.
1 Appuyez légèrement sur [ ] dans le menu DNSe pour 

sélectionner <User> (Utilisateur), puis appuyez sur [ ].
2. Appuyez légèrement sur [ ] pour sélectionner 

<EQ> (EG), puis sur [ ].
L’écran de réglage <EQ> (EG) apparaît.

3. Appuyez légèrement sur [ ] pour sélectionner la 
fréquence que vous souhaitez régler, puis sur [ ]
pour régler le niveau de la fréquence sélectionnée.

Pour le réglage de la fonction <EQ> (EG), vous pouvez 
sélectionner une valeur comprise entre -10 et +10.

4. Appuyez légèrement sur [ ].
Le réglage est terminé.

<3D&BASS>
Vous pouvez régler le son ambiophonique 3D et le niveau d’amplifi cation 
des basses fréquences.
1. Appuyez légèrement sur [ ] dans le menu DNSe pour 

sélectionner <User> (Utilisateur), puis appuyez sur [ ].
2. Appuyez légèrement sur [ ] pour sélectionner 

<3D & BASS>, puis sur [ ].
L’écran de réglage <3D&Bass> apparaît.

3. Appuyez légèrement sur [ ] pour sélectionner 
<3D> ou <BASS>, puis sur [ ].

Vous pouvez sélectionner un niveau <3D> compris 
entre 0 et 4 et <BASS> compris entre 0 et 4.

4. Appuyez légèrement sur [ ].
Le réglage est terminé.

EQ
3D & BASS

EQ
3D & BASS 
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UTILISATION DU MENU MUSIQUE (Suite)
Régler le mode de lecture
Permet de sélectionner le mode de lecture tel que les paramètres de 
répétition.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Play Mode> (Mode lecture), puis sur [ ].

Le menu <Play Mode> (Mode lecture) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
le mode de votre choix, puis sur [ ].

Choisissez entre <Normal>, <Repeat> (Répéter), 
<Repeat One> (Répéter 1X) et <Shuffl e> (Aléatoire).

Options du mode de lecture
Normal : Permet de lire toutes les plages dans l'ordre une seule fois.
Repeat (Répéter) : Permet de répéter tous les fi chiers du dossier en cours.
Repeat One (Répéter 1X) : Permet de répéter un fi chier.
Shuffl e (Aléatoire) : Permet de lire les fi chiers dans un ordre aléatoire.

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Connect to Headset
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UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner l’écran de lecture musicale
Sélectionnez une image de fond d’écran parmi celles fournies ou sélectionnez 
l’une de vos propres images à affi cher lorsque vous écoutez de la musique.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Music Play Screen> (Ecran Lect mus.), puis sur [ ].

Le menu <Music Play Screen> (Ecran Lect mus.) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
l’écran de lecture musicale souhaité, puis sur [ ].

Choisissez entre <Type 1>, <Type 2>, <Type 3>,<Type 
4>, <Album Art> (Image CD) et <Album Info.> (Info. 
Album).

Options de l’écran de lecture musicale
Type 1 ~ Type 4 (Type 1 à Type 4) : Permet de sélectionner l’écran de lecture 
musicale souhaité.
Album Art (Image CD) : L’image de la jaquette du CD s'affi che si une image 
de jaquette fi gure dans les informations de l’étiquette 3D du fi chier musical. Les 
images de la jaquette du CD d’une taille inférieure à 200 pixels (horizontal) x 
200 pixels (vertical) sont prises en charge.
Album Info. (Info.album) : Les informations concernant le nom de l’artiste, 
l’album et le genre s’affi chent si celles de l’étiquette ID3 sont enregistrées dans 
le fi chier musical.

Si vous réglez <Sammy>dans <Menu Design> (Aspect du menu), <Album 
Art> (Image CD) ne peut pas être affi ché.
Qu’est-ce que l’étiquette ID3?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations 
relatives au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et 
un champ commentaire.

REMARQUE

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Connect to Headset
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la vitesse de lecture
Accélérez ou ralentissez votre musique préférée en réglant la vitesse de lecture.
1. Appuyez légèrement sur [ ] tout en écoutant de la musique.

Le menu <Music> (Musique) s’affi che.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Play Speed> (Vitesse de lecture), puis sur [ ].
Le menu <Play Speed> (Vitesse de lecture) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner la 
vitesse de lecture souhaitée, puis sur [ ].

Choisissez entre <X 0.7>, <X0.8>, <X 0.9>, 
<X 1.0(Normal)>, <X 1.1>, <X 1.2> et <X 1.3>.
Plus le nombre est élevé, plus la vitesse est rapide.

La vitesse de lecture réglée peut être légèrement différente de la vitesse 
réelle en fonction du fi chier.

Régler l’intervalle de saut
Vous pouvez avancer rapidement dans un fi chier à intervalles variés. 
autez l’ensemble de la plage ou sautez plusieurs secondes à la fois.
1. Appuyez légèrement sur [ ] tout en écoutant de la musique.

Le menu <Music> (Musique) s’affi che.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Skip Interval> (Saut Intervalle), puis sur [ ].
Le menu <Skip Interval> (Saut Intervalle) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
l’intervalle de saut souhaité, puis sur [ ].

Choisissez entre <1 Song> (1 chanson), <5sec>, 
<10sec>, <30sec> et <1min>.

Si le fi chier a été ouvert avec un débit binaire 
variable, il se peut que la longueur réelle de l’intervalle de saut soit 
légèrement différente de celle que vous avez sélectionnée.

REMARQUE

REMARQUE

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Connect to Headset

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Connect to Headset
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UTILISATION DU MENU MUSIQUE (Suite)
Avant de démarrer- Utilisez uniquement les écouteurs stéréo certifi és Bluetooth. 
Assurez-vous que vos écouteurs stéréo Bluetooth ont bien été enregistrés. 
<Connect to Headset> (Relier les écouteurs) s’affi che lorsque les écouteurs sont 
enregistrés. Pour de plus amples informations, reportez-vous à <Utilisation des 
écouteurs stéréo Bluetooth>. Reportez-vous à la page 91.

Relier des écouteurs stéréo Bluetooth
Vous pouvez relier directement les écouteurs stéréo Bluetooth 
enregistrés pendant la lecture musicale.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Connect to Headset> (Relier les écouteurs), 
puis sur [ ].

Si <Bluetooth Mode> (Mode Bluetooth) est réglé sur 
<Off> (Arrêt), il passe à <On> (Marche).
Une fois la connexion établie, l’icône [ ] s’affi che. 
Vous pouvez écouter de la musique via les écouteurs 
Bluetooth.

Déconnecter les écouteurs stéréo Bluetooth
1. Appuyez légèrement sur [ ] tout en écoutant de la musique.

Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Disconnect Headset> (Débrancher écouteurs), 
puis sur [ ].

Les écouteurs Bluetooth sont déconnectés.
Lorsque les écouteurs stéréo Bluetooth sont 
raccordés au lecteur en mode Musique, les fonctions 
<Play Speed> (Vitesse de lecture), <DNSe> et 
<Sound Effect> (Effets Sonores) ne peuvent pas être 
réglées.

REMARQUE

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Connect to Headset

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Disconnect Headset
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regarder une vidéo
Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 
batterie. Transférez un fi chier vidéo vers le lecteur. Reportez-vous à la page 36~38
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur [ ] pour sélectionner <Videos> 
(Vidéos), puis sur [ ].

La liste des vidéos s'affi che.

3. Appuyez légèrement sur [ ] pour sélectionner la vidéo 
que vous souhaitez lire, puis sur [ ].

La lecture du fi chier vidéo sélectionné démarre horizontalement.

METTRE EN PAUSE PENDANT LA LECTURE
1. Appuyez légèrement sur [ ] pendant la lecture de la vidéo.

Le lecteur met la lecture en pause.

2. Appuyez à nouveau sur [ ].
Le lecteur reprend au dernier point de lecture.

Avant le transfert du fi chier vidéo vers le lecteur à l'aide du logiciel <Samsung 
Media Studio>, le fi chier est tout d’abord converti automatiquement au format SVI. 
La taille du fi chier est également réglée automatiquement.

REMARQUE

REMARQUE
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PASSER A UNE SEQUENCE SPECIFIQUE
1. En affi chage horizontal, appuyez longuement 

sur [ ].
Cette option vous permet de reculer ou d’avancer dans le 
fi chier vidéo en cours.

2. Relâchez le bouton une fois la position souhaitée 
atteinte.

La lecture de la vidéo démarre à partir 
de cette position.

LIRE LE FICHIER VIDEO PRECEDENT
1. Appuyez légèrement sur [ ] dans les 3 secondes 

suivant le démarrage de la lecture du fi chier en 
cours.
Appuyez deux fois sur [ ] 3 secondes après le 
démarrage de la lecture du fi chier en cours.

Cette opération permet de revenir à la vidéo précédente.

LIRE LE FICHIER VIDEO SUIVANT
1. Appuyez légèrement sur [ ].

Cette opération permet d’accéder au fi lm suivant.

Video Track 1

Video Track 1

Video Track 2
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UTILISATION DU MENU VIDEO
Réglage d'un signet
La défi nition d'un signet vous permet de retrouver facilement la position 
correspondante ultérieurement.
1. Appuyez légèrement sur [ ] pour affi cher la 

scène souhaitée durant la lecture de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Add Bookmark> (Ajouter 
signet), puis sur [ ].

Le point de lecture/d'arrêt courant est ajouté au signet.
Le symbole [  ] apparaît dans la barre de progression de la lecture.

La fenêtre Réécrire apparaît si un signet a déjà été défi ni. Si vous sélectionnez <Yes> 
(Oui), le signet préalablement défi ni est supprimé et un nouveau signet est ajouté.
Un signet peut être ajouté pour chaque fi chier vidéo (50 signets maxi.).

Accéder à lire/Supprimer un signet
1. Appuyez légèrement sur [ ] pendant la lecture 

de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Go to Bookmark> (Accéd. à 
signet) ou <Delete Bookmark> (Supprimer 
signet), puis sur [ ].

Lorsque vous avez sélectionné <Go to Bookmark> (Accéd. à Signet), le lecteur accède  
 au signet sélectionné et commence la lecture.

L’option <Delete Bookmark> (Supprimer signet) permet de supprimer le signet 
sélectionné du fi chier vidéo.

Pour quitter le menu, appuyez légèrement sur [ ].

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe
Connect to Headset

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe
Connect to Headset

REMARQUE

REMARQUE
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UTILISATION DU MENU VIDEO (Suite)
Pour quitter le menu, appuyez légèrement sur [ ].

Régler la luminosité
Vous pouvez régler la luminosité de l’écran.
1. Appuyez légèrement sur [ ] pendant la 

lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Brightness> (Luminosité), 
puis sur [ ].

Le menu <Brightness> (Luminosité) s’affi che.
3. Appuyez légèrement sur [ ] pour sélectionner la luminosité de 

votre choix, puis sur [ ].
Choisissez entre <0~10>.

Régler la fonction Digital Natural Sound engine (DNSe)
Permet de choisir le type de son convenant le mieux à chaque genre 
de vidéo.
1. Appuyez légèrement sur [ ] pendant la 

lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <DNSe> (Luminosité), puis sur [ ].

Le menu <DNSe> s’affi che.
3. Appuyez légèrement sur [ ] pour 

sélectionner le DNSe de votre choix, puis sur [ ].
Choisissez entre <Normal>, <Drama> (Drame) et <Action>.

Qu’est-ce que la fonctionnalité DNSe?
La technologie Digital Natural Sound Engine (DNSe) est une fonction d’optimisation 
du son conçue par Samsung pour les lecteurs MP3. Cette option offre différents 
réglages sonores visant à améliorer le type de musique que vous écoutez.

REMARQUE

REMARQUE

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe
Connect to Headset

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe
Connect to Headset
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UTILISATION DU MENU VIDEO (Suite)
Avant de démarrer - Utilisez uniquement les écouteurs stéréo certifi és 
Bluetooth. Assurez-vous que vos écouteurs stéréo Bluetooth ont bien été 
enregistrés. <Connect to Headset> (Relier les écouteurs) s’affi che lorsque les 
écouteurs sont enregistrés. Pour de plus amples informations, reportez-vous 
à <Utilisation des écouteurs stéréo Bluetooth>. Reportez-vous à la page 91.

Relier des écouteurs stéréo Bluetooth
Vous pouvez relier directement des écouteurs Bluetooth enregistrés 
pendant la lecture de la vidéo.
1. Appuyez légèrement sur [ ] pendant la 

lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Connect to Stereo Headset>
(Relier les écouteurs stéréo), puis sur [ ].

Si <Bluetooth Mode> (Mode Bluetooth) est 
réglé sur <Off> (Arrêt), il passe à <On> (Marche).
Une fois la connexion établie, l’icône [ ] s’affi che à l’écran.
Vous pouvez écouter le son du fi chier vidéo via les écouteurs stéréo.

Déconnecter les écouteurs stéréo Bluetooth
1. Appuyez légèrement sur [ ] pendant la 

lecture de la vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Disconnect Headset>
(Débrancher écouteurs), puis sur [ ].

Les écouteurs Bluetooth sont déconnectés.

Lorsque les écouteurs stéréo Bluetooth sont raccordés au lecteur en mode 
Vidéo, la fonction <DNSe> ne peut pas être réglée.REMARQUE

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe
Connect to Headset

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe
Disconnect Headset
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affi chage des images
Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Pictures> (Images), puis sur [ ].

La fenêtre de prévisualisation apparaît.

3. Appuyez légèrement sur [ ] pour sélectionner 
l’image que vous souhaitez affi cher, puis sur [ ].

L’image sélectionnée s'affi che.
Appuyez légèrement su [ ] pour aller à la fenêtre de 
prévisualisation.

Accéder à l’image précédente/suivante
1. En affi chage horizontal, appuyez légèrement sur [ ].

L’image précédente/suivante s'affi che.

Un fi chier JPG comportant des données incorrectes sous forme de vignette s’affi che 
dans .
Certaines images peuvent être affi chées lentement.
Avant le transfert du fi chier image vers le lecteur à l'aide du logiciel <Samsung 
Media Studio>, celui-ci est tout d’abord converti automatiquement au format JPG. 
La taille du fi chier est également réglée automatiquement.
Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) 
pour rechercher une image. Reportez-vous à la page 21.

REMARQUE

REMARQUE
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REMARQUE

UTILISATION DU MENU IMAGE
Pour quitter le menu, appuyez légèrement sur [ ].

Ecouter de la musique pendant l’affi chage de votre image
Vous pouvez écouter la dernière chanson lue pendant l’affi chage de 
votre image.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Music> (Musique), puis sur [ ].

Le menu <Music> (Musique) s’affi che.

3. Appuyez légèrement sur [ ] pour 
sélectionner <Off> (Arrêt) ou <On> (Marche), puis sur [ ].

<Off> (Arrêt) : aucune musique de fond ne peut être lue pendant l’affi chage 
d’une image.
<On> (Marche) : vous pouvez écouter la dernière musique lue pendant 
l’affi chage de votre image.

Visionner un diaporama
Marche à suivre  1
1. Appuyez légèrement sur [ ] pendant l’affi chage 

de l’image.
Le symbole  s’affi che à l’écran et le lecteur démarre 
le diaporama.

Marche à suivre  2
1. En mode de prévisualisation de l’image, appuyez 

légèrement sur [ ].
La fenêtre Démarrer diaporama apparaît.

2. Appuyez légèrement sur [ ].
Le symbole  s’affi che à l’écran et le lecteur démarre  

 le diaporama.

Music
Start Slideshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Start Slideshow
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UTILISATION DU MENU IMAGE (Suite)
Arrêt du diaporama

Marche à suivre  1
1. En mode diaporama, appuyez légèrement 

sur [ ].
Le diaporama s’arrête.

Marche à suivre  2
1. En mode diaporama, appuyez légèrement 

sur [ ].
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Stop Slideshow> (Arrêt diaporama), puis sur [ ].

Le diaporama s’arrête.

Régler la vitesse du diaporama
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Slideshow Speed>
(Vitesse diaporama), puis sur [ ].

Le menu <Slideshow Speed> (Vitesse 
diaporama) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner la vitesse de votre 
choix, puis sur [ ].

Choisissez entre <Fast> (Rapide), <Normal> et <Slow> (Lent).

Music
Stop Slideshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Music
Stop Slideshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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UTILISATION DU MENU IMAGE (Suite)
Agrandir une image
Vous pouvez zoomer sur une image.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Zoom> (Zoom), puis sur [ ].

Le menu <Zoom> (Zoom) s’affi che.
3. Appuyez légèrement sur [ ] pour 

sélectionner l’échelle souhaitée, puis sur 
 [ ].

Choisissez entre <100%>, <200%> et <400%>.
4. Appuyez légèrement sur [ ] pour accéder à la partie de 

l’image que vous souhaitez agrandir.
Annuler le zoom
Marche à suivre  1
1. Appuyez légèrement sur [ ] dans une 

vue agrandie de l’image.
Cette fonction permet de revenir à la taille initiale.

Marche à suivre  2
1. Appuyez légèrement sur [ ] dans une vue 

agrandie de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Zoom> (Zoom), puis sur [ ].

Le menu <Zoom> (Zoom) s’affi che.
3. Appuyez légèrement sur [ ] pour sélectionner <100%>, puis sur [ ].

Cette fonction permet de revenir à la taille initiale.

L’agrandissement d’un fi chier image volumineux peut prendre un certain temps.
REMARQUE

Music
Start Slideshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

 100%
 200%
 400%
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UTILISATION DU MENU IMAGE (Suite)
Pour faire pivoter une image
Vous pouvez faire pivoter l’image selon vos envies.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Rotate> (Pivoter), puis sur

  [ ].
Le menu <Rotate> (Pivoter) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner l’angle de votre 
choix, puis sur [ ].

Choisissez entre <Left 90°> (Gauch 90°), <Right 90°> (90° droite) et <180°>.

Sélectionner une image comme fond d’écran
Vous pouvez défi nir l’image de votre choix comme fond d’écran.
1. Sélectionnez le fi chier image à défi nir 

comme image de fond d'écran et appuyez 
légèrement sur [ ].

Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur [ ] pour 
sélectionner <Select as My Skin>
(Sélectionner comme habillage), puis sur [ ].

La fenêtre de confi rmation d’enregistrement apparaît.

3. Appuyez légèrement sur [ ] pour sélectionner <Yes> (Oui),
puis sur [ ].

L’image sélectionnée est réglée comme image de fond d’écran..

Music
Start Slideshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Music
Start Slideshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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ecouter la radio FM
Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur [ ] pour sélectionner 
<FM Radio> (Radio FM), puis sur [ ].

La réception de la radio FM est activée.

POUR UTILISER LA FONCTION MUTE (SILENCE)
Appuyez légèrement sur [ ] lorsque vous écoutez la radio FM.

Le son est désactivé.

Appuyez à nouveau sur [ ] pour reprendre l’écoute.

Branchez toujours vos écouteurs sur le lecteur lorsque vous recherchez ou réglez 
des fréquences. Les écouteurs sont utilisés comme antennes de réception des 
ondes FM.
Dans les zones où la qualité de réception est mauvaise, il se peut que le lecteur ne 
détecte aucune fréquence FM. 
La fonction Bluetooth ne peut pas être utilisée lorsque vous écoutez la radio FM.

REMARQUE

REMARQUE
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POUR RECHERCHER DES STATIONS DE RADIO FM
1. Appuyez longuement sur [ ] et relâchez en mode 

Manuel.
Le message <Auto Searching....> (Recherche auto en cours…) 
s’affi che à l’écran.
La recherche s’arrête sur la fréquence la plus proche du point de 
relâchement du bouton.

OU,

1. Appuyez légèrement sur [ ] pour rechercher les 
fréquences une par une en mode Manuel.

Change de fréquence à chaque nouvelle pression du bouton.

MANUAL

Auto Seaching...

MANUAL
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UTILISATION DU MENU DE LA RADIO FM
Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer 
une recherche manuelle d’une fréquence à la fois sur 
la bande FM.
1. Appuyez légèrement sur [ ] en mode Manuel.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Go to Preset Mode> (Aller au mode pré-
programmation), puis sur [ ].

<PRESET> s’affi che.

Si aucune fréquence de présélection n’est défi nie, le message 
<Preset list does not exist> (Liste présél. n’existe pas.) s’affi che et le 
lecteur ne passe pas en <Preset Mode> (Mode Présélection).
Si vous sélectionnez <Default Set> (Réglage par défaut) dans 
<Settings> (Paramètres)  <System> (Système), toutes les fréquences de 
présélection sont supprimées.

Pour basculer vers le Mode présélection
Sélectionnez ce mode si vous souhaitez effectuer 
une recherche de vos présélections FM une à la fois.
1. Appuyez légèrement sur [ ] en mode 

Présélection.
Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Go to Manual Mode> (Aller au mode manuel), 
puis sur [ ].

<MANUAL> s’affi che.

REMARQUE

PRESET

MANUAL
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour enregistrer des stations dans la mémoire de 
présélection
Vous pouvez enregistrer jusqu’à 30 stations dans la mémoire de votre 
lecteur MP3 et y accéder en appuyant simplement sur un chiffre. 
Le lecteur MP3 peut soit choisir uniquement les stations souhaitées 
(manuellement) ou rechercher et enregistrer automatiquement les 
stations locales.
Manuel : sélectionnez uniquement les stations que vous souhaitez 
enregistrer
1. Appuyez légèrement sur [ ] pour sélectionner 

la fréquence souhaitée en mode Manuel.
Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur [ ].
3. Appuyez légèrement sur [ ] pour sélectionner 

<Add to Preset> (Ajouter aux présél.), puis sur [ ].
La fréquence sélectionnée est ajoutée à la liste de 
présélection avec le symbole [ . ] affi ché sur la barre de 
fréquence sélectionnée.

4. Pour défi nir un numéro préréglé pour les autres fréquences, 
suivez les étapes 1 à 3 ci-dessus.

Si la même fréquence est déjà réglée, le message <This preset already 
exists> (Cette présél. existe déjà.) s’affi che et le réglage est désactivé.REMARQUE

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour enregistrer des stations dans la mémoire de 
présélection (Suite)
Automatique : enregistrez automatiquement toutes les stations 
captées par le lecteur
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Auto Preset> (Présélection auto), puis sur [ ].

Une fenêtre de confi rmation s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Yes> (Oui), puis sur [ ].

Jusqu’à 30 fréquences radio sont réglées 
automatiquement.

Pour annuler la présélection automatique
Si vous souhaitez annuler la présélection automatique, appuyez 
légèrement sur [ ] au cours du processus.

La présélection automatique est annulée et seules les fréquences réglées 
jusque-là sont enregistrées.

Si vous vous rendez dans une autre région avec votre lecteur MP3, 
vous souhaiterez peut-être régler à nouveau les stations enregistrées. 
Pour supprimer les stations préréglées et en enregistrer de nouvelles, 
il suffi t de répéter le processus.

REMARQUE

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour écouter une station présélectionnée
En mode Présélection, appuyez légèrement sur 
[ ] pour faire défi ler les stations présélectionnées.

Vous pouvez écouter la fréquence radio enregistrée.

Pour supprimer une présélection 
Suivez les étapes suivantes pour supprimer les fréquences tout en 
écoutant la radio FM.
1. En mode Présélection, appuyez légèrement 

sur [ ] pour rechercher une fréquence 
présélectionnée à supprimer, puis appuyez sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Delete from Preset> (Suppr. du prérégl.), puis 
sur [ ].

La fréquence sélectionnée est supprimée.

3. Pour supprimer les autres fréquences 
présélectionnées, suivez les étapes 1 à 2 ci-dessus.

PRESET

Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Enregistrer un programme FM
Vous pouvez à tout moment enregistrer un programme FM tout en 
écoutant la radio.
1. Appuyez légèrement sur [ ] pour sélectionner 

une fréquence à enregistrer en mode Radio FM, 
puis sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Start Recording> (Démarrer enreg.), puis sur 
 [ ].

Le nom de fi chier s’affi che et le lecteur démarre 
l’enregistrement.

Arrêter un enregistrement
1. Appuyez légèrement sur [ ] pendant 

l’enregistrement.
Un message apparaît vous demandant si vous souhaitez 
écouter le fi chier que vous venez d’enregistrer.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Yes> (Oui) ou <No> (Non), puis sur [ ].

Sélectionner <Yes> (Oui) vous permet de lire le fi chier 
que vous venez d’enregistrer.
Sélectionner <No> (Non) ne vous permet pas de lire le 
fi chier enregistré.
Le fi chier est enregistré à l’emplacement suivant : <File Browser> (Dossier 
Navigateur)  <Recorded Files> (Fichiers Enregistrés).

Vous pouvez stocker jusqu’à 999 fi chiers pour l’enregistrement radio FM.
Vous pouvez effectuer jusqu’à 23 heures d’enregistrement (sur la base de 
96 Kbps, 1 Go)
Le nom du fi chier enregistré est spécifi é automatiquement sous la forme 
« FM_000.mp3 ». « FM » indique que le fi chier est un enregistrement FM 
et « 000 » correspond au numéro du fi chier enregistré.

REMARQUE

Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour régler la Sensibilité FM
Pour recevoir plus ou moins de fréquences radio FM, paramétrez la 
fonction FM Sensitivity (Sensibilité FM).
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<FM Sensitivity> (Sensibilité FM), puis sur [ ].

Le menu <FM Sensitivity> (Sensibilité FM) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
le niveau de recherche, puis sur [ ].

Choisissez entre <High> (Haut), <Middle> (Milieu) et 
<Low> (Bas).
Le réglage <High> (Haut) vous permet de recevoir le plus grand nombre de 
fréquences.

Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Réglage de la région FM
Vous avez la possibilité de modifi er le réglage FM en prévision d’un 
voyage à l’étranger.
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<FM Region> (Région Radio), puis sur [ ].

Le menu <FM Region> (Région Radio) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
la zone régionale de la radio FM, puis sur [ ].

Choisissez entre <Korea/US> (Corée/USA), <Japan> 
(Japon) ou <Other Countries> (Autres pays).

Les fréquences radio que vous avez enregistrées précédemment seront 
supprimées si vous modifi ez le réglage <FM Region> (Région FM) de votre 
lecteur.
La région FM peut être supprimée ou modifi ée en fonction de la région 
cible du lecteur.
Bande de fréquences par région
- Korea/US (Corée/USA) : Recherchez des fréquences FM comprises entre 
  87,5 MHz et 108,0 MHz pour les lecteurs de 100 kHz.
- Japan (Japon) : Recherchez des fréquences FM comprises entre 76,0 
  MHz et 108 MHz pour les lecteurs de 100 kHz.
- Other Countries (Autres pays) : Recherchez des fréquences FM 

comprises entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.

REMARQUE

Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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utilisation de la diffusion de données
Avec <Samsung Media Studio>, vous pouvez transférer vers le lecteur les 
informations relatives au format RSS.

Qu'est-ce que le format RSS?
RSS correspond à Rich Site Summary ou Really Simple Syndication. Il s’agit d’un système 
de transfert de données XML utilisé pour fournir aux utilisateurs, de manière plus pratique et 
plus facile, des informations sur les sites Internet fréquemment mis à jour (Actualités, Blogs).
Qu’est-ce que la diffusion de données?
Vous pouvez recevoir automatiquement les informations mises à jour sans avoir à 
vous rendre sur les sites d’actualités, les blogs ou les UCC.
Avant de démarrer – Samsung Media Studio doit être installé sur l'ordinateur. 

Reportez-vous à la page 35.

ENREGISTREMENT D’UNE CHAINE
Vous pouvez créer une nouvelle chaîne en enregistr.ant les sites Internet ou les 
pages Web pris(es) en charge par le système RSS.
1. Cliquez sur le bouton <Subscribe>

(S’abonner) situé au bas de l’écran 
<Datacasts> (Dif. donn.) de <Samsung 
Media Studio>.

2. Saisissez une adresse dans <URL> (URL) 
et cliquez sur < Next> ( Suivant).

Lorsque vous copiez une adresse Internet 
et que vous cliquez sur <Subscribe> 
(S’abonner), l’adresse copiée s’affi che automatiquement dans l’<URL> (URL).
La fenêtre de confi rmation du réglage s’affi che si l’adresse Internet prend en charge le 
format RSS.

3. Cliquez sur <OK>.
La chaîne souhaitée est enregistrée.
L’icône  s’affi che dans Datacasts (Dif. donn.) pour le canal enregistré.

Reportez-vous à <Datacasts> (Dif. donn.) de <Media Studio> pour obtenir des instructions détaillées

REMARQUE

2
2

REMARQUE
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CREATION D’UN NOUVEAU GROUPE DE CHAINES
Vous pouvez créer un nouveau groupe afi n de gérer les chaînes par catégorie.
1. Cliquez sur le bouton <New Group> (Nouveau 

groupe) situé au bas de l’écran <Datacasts>
(Dif. donn.) de <Samsung Media Studio>.

2. Saisissez un nom de groupe et une description 
et cliquez sur <OK>.

TRANSFERT DE LA DIFFUSION 
DES DONNEES DEPUIS 
<SAMSUNG MEDIA STUDIO>

Avant de démarrer – Branchez le lecteur sur l'ordinateur. Samsung Media Studio doit être 
installé sur l'ordinateur. Reportez-vous à la page 35.

1. <Samsung Media Studio> démarre 
automatiquement lorsque vous branchez le 
lecteur sur votre ordinateur.

Si le programme ne démarre pas automatiquement, 
double-cliquez sur l'icône  <Samsung Media 
Studio> située sur le Bureau.

2. Cliquez sur <Datacasts> (Dif. donn.) située 
dans la partie supérieure de <Samsung 
Media Studio>.

La liste de chaînes du groupe de diffusion de 
données s’affi che.

3. Cliquez sur la chaîne du groupe souhaité.
4. Cliquez sur la chaîne souhaitée.
5. Sélectionnez l’élément que vous souhaitez transférer.
6. Cliquez sur l'icône .

L’élément de la chaîne sélectionnée est transféré vers le lecteur dans <File Browser> (Dossier 
Navigateur)  <Datacasts> (Dif. donn.).

Cliquez sur  dans la partie supérieure de <Samsung Media Studio> pour accéder à l’écran 
précédent.
Dans <Datacasts> (Dif. donn.) de <Samsung Media Studio>, si l’élément comporte une pièce 
jointe, vous pouvez télécharger ce dernier sur le lecteur. Cependant, il est possible que le fi chier 
joint ne puisse pas être téléchargé en fonction de la politique de sécurité du site Internet.

REMARQUE

2

6
5

2
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AFFICHAGE DES DIFFUSIONS DE DONNEES
Vous pouvez affi cher les éléments de chaîne ajoutés à <Datacasts> (Dif. donn.).

Avant de démarrer- Transférez l’élément de la chaîne souhaitée vers le lecteur 
avec <Samsung Media Studio>. Reportez-vous à la page 76.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Datacasts> (Dif. donn.), puis sur [ ].

La liste de diffusion s'affi che.

3. Appuyez légèrement sur [ ] pour sélectionner la 
chaîne du groupe souhaité, puis sur [ ].

Le titre est le même que celui de la chaîne ajoutée à 
<Datacasts> (Dif. donn.) dans <Samsung Media Studio>.

4. Appuyez légèrement sur [ ] pour sélectionner la chaîne souhaitée, puis 
sur [ ].

La liste des fi chiers s'affi che.

Icône  : Texte principal de l’élément transféré
Icône : Fichier image
Icône  : Fichier musical
Icône : Fichier vidéo

5. Appuyez légèrement sur [ ] pour sélectionner 
l’élément souhaité, 
puis sur [ ].

L’élément sélectionné est lu.

REMARQUE

Datacast 1
Datacast 2
Datacast 3
Datacast 4
Datacast 5
Datacast 6

Datacasts
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utilisation du pack plus
Le pack plus vous permet d’utiliser différentes fonctions telles que la 
lecture du texte et l’enregistrement vocal.
LECTURE DU TEXTE
Qu’il s’agisse d’un roman, d’un scénario ou d’un article, votre lecteur MP3 vous permet de 
le lire tout en écoutant de la musique !

Avant de démarrer- Allumez le lecteur et vérifi ez la batterie. Transférez les fi chiers 
texte vers le lecteur à l’aide de <Samsung Media Studio>. Reportez-vous à la page 
36~38.
Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) s’affi che.
3. Appuyez légèrement sur [ ] pour sélectionner <Text>

(Texte), puis sur [ ].
La liste des fi chiers texte s'affi che.

4. Appuyez légèrement sur [ ] pour sélectionner le fi chier 
texte souhaité, puis sur [ ].

Le texte s'affi che à l'écran.
Accéder à la page précédente/suivante
Appuyez légèrement sur [ ].

Appuyez longuement sur [ ] pour accéder de manière continue à la page 
précédente/suivante.

Votre lecteur MP3 prend en charge les fi chiers au format TXT en mode Texte.
Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) 
pour rechercher un fi chier texte.

REMARQUE

REMARQUE

Text
Voice REC
Games
Address Book

Prime Pack
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UTILISATION DU MENU TEXTE
Pour quitter le menu, appuyez légèrement sur [ ].

Ecouter de la musique pendant l’affi chage de votre texte
Vous pouvez écouter la dernière musique lue pendant l’affi chage de votre texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage du texte.

Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Music> (Musique), puis sur [ ].

Le menu <Music> (Musique) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
le mode de votre choix, puis sur [ ].

<Off> (Arrêt) :  Aucune musique de fond ne peut être 
lue pendant l’affi chage de votre texte.

<On> (Marche) : Vous pouvez écouter la dernière musique lue pendant 
l’affi chage de votre texte.

Accéder à la première page
Utilisez cette fonction pour affi cher le texte de la première page.
1. Appuyez légèrement sur [ ] pendant l’affi chage du texte.

Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner <Go
to 1st Page> (Aller à la 1ère page), puis sur [ ].

Utilisez cette fonction pour affi cher le texte de la 
première page.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Yes> (Oui), puis sur [ ].

Permet d’accéder à la première page.

REMARQUE

Music
Go to 1st Page 
Add Bookmark
Go to Bookmark
Delete Bookmark
Text Viewer Color
Font Size
View Type

Music
Go to 1st Page
Add Bookmark
Go to Bookmark
Delete Bookmark
Text Viewer Color
Font Size
View Type
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UTILISATION DU MENU TEXTE (Suite)
Pour quitter le menu, appuyez légèrement sur [ ].

Réglage d'un signet
Défi nissez un signet pour revenir à tout moment à ce point du texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur [ ] pour sélectionner 
<Add Bookmark> (Ajouter signe), puis sur [ ].

L'écran du texte actuel est associé à un signet et le 
symbole [ ] s'affi che dans le coin supérieur gauche. 

La fenêtre Réécrire apparaît si un signet a déjà été 
défi ni. Si vous sélectionnez <Yes> (Oui), le signet 
préalablement défi ni est supprimé et un nouveau signet est ajouté.
Un signet peut être défi ni pour chaque fi chier texte (100 signets au 
maximum).

Accès à/Suppression d’un signet
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur [ ] pour sélectionner 
<Go to Bookmark> (Accéd. à Signet) ou <Delete
bookmark> (Supprimer signet), puis sur [ ].

Vous accédez au signet sélectionné lorsque vous 
cliquez sur <Go to Bookmark> (Accéd. à Signet) et le 
supprimez du fi chier texte lorsque vous sélectionnez 
<Delete Bookmark> (Supprimer signet).

REMARQUE

REMARQUE

Music
Go to 1st Page
Add Bookmark
Go to Bookmark
Delete Bookmark
Text Viewer Color
Font Size
View Type

Music
Go to 1st Page
Add Bookmark
Go to Bookmark
Delete Bookmark
Text Viewer Color
Font Size
View Type
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UTILISATION DU MENU TEXTE (Suite)
Réglage de la couleur de la visionneuse de texte
Choisissez la couleur d’affi chage du texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur [ ] pour sélectionner 
<Text Viewer Color> (Coul. visionn. text), puis 
sur [ ].

La fenêtre du menu <Text Viewer Color> (Coul. 
visionn. text) apparaît.

3. Appuyez légèrement sur [ ] pour sélectionner 
la couleur de la visionneuse de texte souhaitée, puis sur [ ].

Options disponibles : <Type 1> à <Type 6>.

Modifi er la taille de la police
Vous pouvez modifi er la taille de la police utilisée dans le texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur [ ] pour sélectionner 
<Font Size> (Taille police), puis sur [ ].

Le menu <Font Size> (Taille police) s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
la taille de police souhaitée, puis sur [ ].

Choisissez entre <Small> (Petit), <Medium> (Moyen) et <Large>.

Music
Go to 1st Page
Add Bookmark
Go to Bookmark
Delete Bookmark
Text Viewer Color
Font Size 
View Type

Music
Go to 1st Page
Add Bookmark
Go to Bookmark
Delete Bookmark
Text Viewer Color 
Font Size
View Type
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Music
Go to 1st Page
Add Bookmark
Go to Bookmark
Delete Bookmark
Text Viewer Color 
Font Size
View Type

UTILISATION DU MENU TEXTE (Suite)
Réglage du type d’affi chage du texte
Vous pouvez affi cher le texte horizontalement ou verticalement
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<View Type> (Type d’affi chage), puis sur [ ].

L’écran <View Type> (Type d’affi chage) apparaît.

3. Appuyez légèrement sur [ ] pour sélectionner 
l’affi chage voulu, puis sur [ ].

Choisissez entre <Normal> (Normal) et <Horizontal> (Horizontal).
Choisissez <Normal> (Normal) pour affi cher le texte à la verticale et 
choisissez <Horizontal> (Horizontal) pour faire pivoter l’écran à l’horizontale.
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UTILISATION DU MENU TEXTE (Suite)
Régler la langue du texte
Vous pouvez sélectionner la langue du texte à affi cher.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur [ ] pour sélectionner 
<Language> (Langue), puis sur [ ].

La liste <Language> (Langue) s’affi che.
<English>, <Korean>, <French>, <German>, 
<Italian>, <Japanese>, <Chinese(S)>, <Chinese(T)>, 
<Spanish>, <Russian>, <Hungarian>, <Dutch>, 
<Polish>, <Portuguese>, <Swedish>, <Thai>, 
<Finnish>, <Danish>, <Norwegian>, <Farsi>, 
<Afrikaans>, <Basque>, <Catalan>, <Czech>, <Estonian>, <Greek>, 
<Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, <Slovene>, <Turkish>, 
<Vietnamese>.

3. Appuyez légèrement sur [ ] pour sélectionner la langue de votre 
choix, puis sur [ ].

Vous pouvez affi cher le texte dans la langue sélectionnée.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
REMARQUE

Language
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ENREGISTREMENT VOCAL 
Vous permet d’effectuer un enregistrement vocal.

Créer un enregistrement vocal
1. Appuyez longuement sur [ ] pour accéder à l’écran du menu 

principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Prime Pack> (Pack plus), puis sur [ ].
Le menu <Prime Pack> (Pack plus) apparaît. 

3. Appuyez légèrement sur [ ] pour sélectionner 
<Voice REC> (ENR vocal), puis sur [ ].

4. Appuyez légèrement sur [ ].
Le lecteur démarre l’enregistrement.

Vous pouvez effectuer jusqu’à 23 heures 
d’enregistrement (sur la base de 96 Kbps, 1 Go)
Vous pouvez stocker jusqu’à 999 fi chiers pour l’enregistrement vocal.

REMARQUE

Text
Voice REC
Games
Address Book

Prime Pack
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ENREGISTREMENT VOCAL (Suite)

Arrêter l’enregistrement vocal
1. Appuyez légèrement sur [ ] pendant 

l’enregistrement.
Un message apparaît vous demandant si vous 
souhaitez écouter le fi chier que vous venez 
d’enregistrer.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Yes> (Oui) ou <No> (Non), puis sur [ ].

Sélectionner <Yes> (Oui) vous permet de lire le fi chier 
que vous venez d’enregistrer.
Sélectionner <No> (Non) ne vous permet pas de lire le fi chier enregistré.
Le fi chier est enregistré à l’emplacement suivant : <File Browser> (Dossier 
Navigateur)  <Recorded Files> (Fichiers Enregistrés).

Ne tenez pas le microphone trop rapproché ou trop éloigné de votre 
bouche car cela pourrait affecter la qualité de l’enregistrement.
L’enregistrement vocal n’est pas optimal lorsque la batterie est trop faible.
Le nom du fi chier enregistré est spécifi é automatiquement sous la forme 
« VCE_000.mp3 ». « VCE » indique que le fi chier est un enregistrement 
vocal et « 000 » correspond au numéro du fi chier enregistré.

REMARQUE
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LECTURE DE JEUX VIDEO
Votre lecteur mp3 est livré avec des jeux passionnants qui sont préchargés sur l’unité !

Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie
Appuyez légèrement sur [ ] pour aller à l’écran précédent.

 Appuyez longuement su [ ] pour accéder à l’écran du menu principal.

1.Appuyez longuement sur [ ] pour accéder à l’écran du menu 
principal.

2.Appuyez légèrement sur [ ] pour sélectionner <Prime
Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) s’affi che

3. Appuyez légèrement sur [ ] pour sélectionner <Games>
(Jeux), puis appuyez sur [ ].

La liste <Games> (Jeux) s’affi che.

4. Appuyez légèrement sur [ ] pour sélectionner le jeu de 
votre choix, puis appuyez sur [ ].

BOMB BOMB
Ce jeu de réfl exion consiste à déplacer trois blocs afi n de faire 
correspondre la couleur des blocs en forme de marteau avec celle des 
blocs empilés, action qui permet de faire disparaître les blocs. Enlevez 
autant de blocs que possible.
Appuyez légèrement sur [ ] pour faire bouger les 
blocs de droite à gauche et inversement.
Appuyez légèrement sur [ ] pour déplacer un bloc 
sur le plan horizontal ou vertical.
Appuyez légèrement sur [ ] pour faire descendre 
rapidement un bloc.

Text
Voice REC
Games
Address Book

Prime Pack

REMARQUE
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LECTURE DE JEUX VIDEO (Suite)
Bubble Smile
Vous devez marquer le plus de points possibles en déplaçant trois 
bulles afi n de les aligner à l’horizontale ou en diagonale.

Appuyez légèrement sur [ ] pour changer la 
combinaison des 3 bulles.

Appuyez légèrement sur [ ] pour déplacer les 3 
bulles dans le sens des aiguilles d’une montre.

Appuyez légèrement sur [ ] pour déplacer les 3 
bulles dans le sens contraire des aiguilles d’une 
montre.
Vous ne marquerez des points que si au moins trois 
bulles sont alignées.

Chicken Runaway

Ce jeu consiste à déplacer une poule et des poulets de droite à gauche 
et inversement, dans le but d’éviter les balles qui 
tombent du ciel afi n que la poule reste en sécurité le 
plus longtemps possible.

Appuyez légèrement sur [ ] pour déplacer la 
poule vers la droite ou vers la gauche.

Des jeux peuvent être ajoutés ou modifi és sans avis préalable.
Pour plus d'informations sur les règles du jeu, consultez la section Aide.REMARQUE
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AFFICHAGE DU CARNET D’ADRESSES
Vous pouvez télécharger le carnet d’adresses en utilisant la fonction Bluetooth pour 
vérifi er le numéro de téléphone et appeler directement votre interlocuteur sur le lecteur.

Avant de démarrer  - Utilisez tout d’abord la fonction de transfert des fi chiers Bluetooth pour 
télécharger le carnet d’adresses à partir d’un périphérique externe. Pour plus d’informations, reportez-
vous à <Transfert d’un fi chier du périphérique externe vers le lecteur>. Reportez-vous à la page 104.
Vous devez coupler votre téléphone mobile avec le lecteur avant de pouvoir effectuer un appel dans 
la fenêtre du carnet d’adresses. Pour de plus amples informations, reportez-vous à <Utilisation d’un 
telephone portable bluetooth>. Reportez-vous à la page 94.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur [ ] pour sélectionner <Prime
Pack> (Pack plus), puis sur [ ].

Le menu <Prime Pack> (Pack plus) apparaît.
3. Appuyez légèrement sur [ ] pour sélectionner 

<Address Book> (Carnet d’adr.) et sur [ ].
La fenêtre Carnet d’adresses apparaît..

4. Appuyez légèrement sur [ ] pour sélectionner le nom à 
vérifi er dans la fenêtre du carnet d’adresses et sur [ ].

Les informations concernant l’adresse sélectionnée s’affi chent.

Pour effectuer un appel à partir du carnet d’adresses
1. Appuyez légèrement sur [ ] pour sélectionner la personne à 

appeler dans la fenêtre du carnet d’adresses et sur [ ].
Les informations concernant l’adresse sélectionnée s’affi chent.

2. Appuyez légèrement sur [ ] pour sélectionner le numéro de 
téléphone désiré et sur [ ].

L’appel vers la personne en question est émis.
Le carnet d’adresses s’affi che progressivement selon les critères suivants : 
caractères spéciaux, numéros, alphabets.
Les fi chiers du carnet d’adresses transférés vers le lecteur sont enregistrés dans le dossier 
<File Browser> (Dossier Navigateur)  <Received Files> (les fi chiers reçus).
Seul le format de fi chier vCard est pris en charge par le carnet d’adresses.

Text
Voice REC
Games
Address Book

Prime Pack

REMARQUE
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utiliser la fonction bluetooth
La technologie Bluetooth sans fi l permet de connecter sans fi l votre lecteur à 
d'autres périphériques Bluetooth et d'échanger des données avec ces derniers, 
de communiquer en mode mains libres ou d'écouter de la musique avec des 
écouteurs stéréo Bluetooth

Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

QU'EST-CE QUE LE SYSTÈME BLUETOOTH?
Bluetooth est une spécifi cation du secteur des télécommunications destinée aux 
réseaux personnels sans fi l. Cette solution vous permet de relier et d’échanger 
des informations entre des périphériques de type téléphones mobiles, 
ordinateurs portables, ordinateurs personnels, imprimantes, appareils photos 
numériques ou consoles de jeux vidéo via des fréquences radioélectriques de 
courte distance généralement de base.
Le périphérique Bluetooth peut engendrer du bruit ou créer des dysfonctionnements 
en fonction des conditions d'utilisation.

Interférences au niveau de la couche physique ; par exemple, si vous tenez le lecteur à 
la main et portez des écouteurs sur les oreilles ou si vous tenez le lecteur dans une main 
et le téléphone portable dans l'autre.
Si une partie du corps est en contact avec le système de réception/transmission du 
lecteur ou des écouteurs stéréo.
Variation électrique suite à un brouillage en raison de l’agencement du mur, de l'angle 
ou du bureau.
Interférence électrique provenant d'appareils utilisant la même bande de fréquences 
(ex. : appareils médicaux, fours à micro-ondes et réseaux LAN).

Lorsque vous associez le périphérique Bluetooth au lecteur, veillez à ce que la 
distance soit la plus courte possible.
Plus le lecteur est éloigné des écouteurs stéréo, moins la qualité est bonne. 
Si la distance excède la limite autorisée, la communication est coupée.
Il est déconseillé d’utiliser les modes d’affi chage texte ou image pendant que vous 
écoutez de la musique avec les écouteurs stéréo, car les performances du lecteur 
et les communications Bluetooth pourraient être altérées.

REMARQUE
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QU'EST-CE QUE LE SYSTÈME BLUETOOTH? (Suite)
En fonction du modèle des écouteurs stéréo, les fi chiers de moins de 32 KHz ne 
peuvent pas être lus. 

Il est possible que la connexion Bluetooth ne fonctionne pas correctement dans 
les zones où la réception est faible (ex. : ascenseur ou sous-sol).

La distance maximale permettant une connexion sans fi l entre le lecteur et le 
système Bluetooth est de 10 m. La connexion s’interrompt automatiquement 
lorsque cette plage est dépassée. Même si la distance est respectée, il est possible 
que la qualité sonore soit détériorée par des obstacles (ex. : murs, portes).

Pour désactiver la fonction Bluetooth, réglez le mode Bluetooth sur <Bluetooth> 
<Bluetooth Mode> (Mode Bluetooth)  <Off> (Arrêt).
Les produits Samsung permettent d'optimiser les fonctions Bluetooth du lecteur. 
Si vous utilisez les fonctions Bluetooth avec des produits d'autres marques, elles 
risquent de ne pas être pleinement opérationnelles.

N’utilisez pas la fonction Bluetooth pour des activités considérées comme illégales 
(piratage, dérivation clandestine ou communications non autorisées à des fi ns 
commerciales). Samsung ne saurait être tenu responsable de ces comportements 
en cas de poursuites.

REMARQUE

ATTENTION
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UTILISATION DES ECOUTEURS STEREO BLUETOOTH
Vous pouvez utiliser des écouteurs stéréo Bluetooth pour écouter de la musique 
avec un son stéréo de haute qualité, tout cela sans fi l !

Avant de démarrer- Si le lecteur a été relié à un téléphone mobile ou un périphérique 
externe Bluetooth, commencez par débrancher la connexion. 
Assurez-vous que le périphérique Bluetooth à connecter est 
prêt à être associé (reportez-vous au manuel d’utilisation de 
l’appareil).

Enregistrer les écouteurs stéréo Bluetooth
(un seul enregistrement suffi t)
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Bluetooth>, puis sur [ ].
La fonction <Bluetooth Mode> (Mode Bluetooth) est 
réglée sur <On> (Marche).
L’icône  s’allume.

3. Préparez les écouteurs stéréo en vue de 
l'association.

Pour préparer les écouteurs stéréo au mode 
d’association, reportez-vous au manuel d’utilisation des écouteurs.

4. Appuyez légèrement sur [ ] pour sélectionner 
<Stereo Headset> (Écouteurs Stéréo), puis sur [ ].
  Le message <Search New Device> (Rech. nv périph) s’affi che à l’écran 
si un périphérique a été préalablement associé au lecteur. Sélectionnez 
<Search New Device> (Rech. nv périph) pour rechercher un nouveau 
périphérique à associer.
Les écouteurs à enregistrer fi gurent dans la liste.

5. Appuyez légèrement sur [ ] pour sélectionner le nom des 
écouteurs à ajouter, puis sur [ ].

La fenêtre de saisie du mot de passe s’affi che si le mot de passe des 
écouteurs est autre que 0000. Reportez-vous au manuel d’utilisation des 
écouteurs pour en savoir plus sur le mot de passe.
Les écouteurs sont enregistrés.
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UTILISATION DES ECOUTEURS STEREO 
BLUETOOTH (Suite)

Enregistrer les écouteurs stéréo Bluetooth (Suite)

Vous pouvez utiliser la fonction Bluetooth pendant la lecture de fi chiers 
musicaux et vidéo uniquement. Cette fonction n’est pas prise en charge 
lorsque vous écoutez la radio FM.

Description des icônes Bluetooth
 : Activation du mode Bluetooth           : Relié à des écouteurs stéréo 

      : Relié à un téléphone mobile

Pour désactiver la fonction Bluetooth, réglez le mode Bluetooth sur 
<Bluetooth>  <Bluetooth Mode> (Mode Bluetooth)  <Off> (Arrêt).

Ecouteurs compatibles Bluetooth
Fabricant Modèle Fabricant Modèle

i.TECH Blueband SAMSUNG SBH100
Plantronics PULSAR 590A Jabra BT620s
MOTOROLA HT820

Utilisez uniquement les casques stéréo certifi és Bluetooth. Les kits piéton 
mono ne sont pas pris en charge.
Lorsque vous n’utilisez pas le mode Bluetooth, réglez la fonction 
<Bluetooth Mode> (Mode Bluetooth) sur <Off> (Arrêt). 
Si la fonction <Bluetooth Mode> (Mode Bluetooth) reste réglée sur 
<On> (Marche), la durée de vie de la batterie diminue. 

REMARQUE
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UTILISATION DES ECOUTEURS STEREO 
BLUETOOTH (Suite)

Relier des écouteurs stéréo Bluetooth enregistrés

1. Appuyez légèrement sur [ ] sur l’écran 
Bluetooth pour sélectionner <Stereo Headset>
(Ecouteurs stéréo), puis sur[ ].

2. Appuyez légèrement sur [ ] pour sélectionner 
les écouteurs stéréo à connecter, puis sur [ ].

Une fois la connexion établie, l’icône  s’affi che.
Vous pouvez relier jusqu'à 2 jeux d’écouteurs.

3. Lisez la musique.
Vous pouvez écouter de la musique à l'aide du casque stéréo.

Si vous ne trouvez pas le casque que vous souhaitez utiliser, procédez tout 
d'abord à son enregistrement.

Si vous éteignez puis allumez le lecteur ou le casque en l'espace d'une 
seconde, la communication Bluetooth est interrompue. 
Si vous souhaitez écouter de la musique à l'aide du casque stéréo, 
répétez les instructions ci-dessus.

Lorsque deux jeux d’écouteurs sont reliés, seul les écouteurs connectés 
en premier peuvent être activés lors de la lecture/l’arrêt et le contrôle du 
volume.
Pour de plus amples informations, reportez-vous au manuel d’utilisation 
des écouteurs.

REMARQUE

Stereo Headset
Mobile Phone
File Transfer
Bluetooth Mode
Bluetooth Settings

Bluetooth
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH
Une fois connecté à un téléphone portable Bluetooth, vous pouvez passer et recevoir des appels 
téléphoniques sur votre lecteur. Le lecteur fonctionne alors comme un appareil mains libres.

Avant de commencer - Si le lecteur est raccordé à des écouteurs stéréo Bluetooth ou à un 
périphérique externe, désactivez d'abord la connexion. Assurez-vous que le téléphone portable 
Bluetooth que vous allez connecter est prêt pour l'association (reportez-vous au manuel 
d'utilisation du téléphone portable). Sélectionnez <Discoverable> (“Découverte” possible) 
dans <Bluetooth Settings> (Paramètres Bluetooth)  <Discover Option> (Options du mode 
“découverte”). Reportez-vous à la page 106.

Pour enregistrer le téléphone portable Bluetooth
(un seul enregistrement suffi t)

1. Appuyez longuement sur [ ] pour accéder à 
l’écran du menu principal.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Bluetooth>, puis sur [ ].

La fonction <Bluetooth Mode> (Mode Bluetooth) est   
 réglée sur <On> (Marche).

L’icône  s’allume.
3. Recherchez YP-T10 dans le menu de votre 

téléphone portable.
Si vous avez renommé le lecteur YP-T10 recherchez le  

 nouveau nom.
4. Saisissez le mot de passe lorsque la fenêtre de saisie du mot de 

passe apparaît sur le téléphone mobile.
5. Lorsque <Connect?> (Se connecter ?) apparaît sur le lecteur, 

appuyez légèrement sur pour sélectionner <Yes> (Oui), puis sur [ ].
La fenêtre de saisie du code PIN (mot de passe) s’affi che.

Les chiffres du mot de passe peuvent varier en fonction du téléphone mobile 
(reportez-vous au manuel d’utilisation du téléphone mobile).

Stereo Headset
Mobile Phone
File Transfer
Bluetooth Mode
Bluetooth Settings

Bluetooth

REMARQUE
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)
Pour enregistrer le téléphone portable Bluetooth  (Suite)

6. Utilisez [ ] et [ ] pour saisir le mot de 
passe du téléphone portable à ajouter au lecteur.

Veillez à saisir le même mot de passe qu'à l'étape 4 
ci-dessus.

7. Utilisez [ ] pour sélectionner <OK>, puis 
appuyez sur [ ].

L'enregistrement du téléphone portable est terminé.

Avec certains téléphones portables, les fonctions de recherche de périphérique 
et de communication mobile (passer/recevoir des appels) risquent de ne pas être 
pleinement opérationnelles.
Si vous appuyez sur un bouton du téléphone portable, passez un appel ou mettez 
fi n à un appel alors qu'une connexion Bluetooth est en cours entre le lecteur et le 
téléphone portable, il se peut que le lecteur émette un bruit.
Nous vous recommandons d'utiliser l'anglais pour le nom de périphérique du 
téléphone portable.
Téléphones portables compatibles Bluetooth

Fabricant Modèle

SAMSUNG
SPH-C3250, SPH-W2700, SPH-V7400, SPH-V6900, SCH-W270,
SPH-B5600, SPH-B3200, SGH-X828, SGH-I718, SGH-E908, SGH-U608

LG LG-KH1000, LG-KV2400, LG-KG90, LG-KG77
SKY IM-U130

NOKIA N72
PHILIPS S900

MOTOROLA Z3

Enter PIN code

REMARQUE
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)
Pour se connecter au téléphone portable Bluetooth 
enregistré
1. Appuyez légèrement sur [ ] idans le menu 

Bluetooth pour sélectionner <Mobile Phone>
(Téléphone mobile), puis sur [ ].

Le menu du téléphone portable s’affi che.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Connect to Mobile Phone> (Relier le tél. 
portable), puis sur [ ].

3. Appuyez légèrement sur [ ] pour sélectionner 
le téléphone portable à contacter, puis sur [ ].

Une fois la connexion établie, l’icône s’affi che.
Si vous ne trouvez pas l'appareil que vous souhaitez relier, commencez par  

 enregistrer l’appareil sur le lecteur. Reportez-vous à la page 94.
Vous pouvez mettre fi n à la connexion avec le téléphone mobile en mettant 
le lecteur hors tension et en le redémarrant. Si la connexion est interrompue, 
reportez-vous aux étapes ci-dessus pour la rétablir.

Pour recomposer le dernier numéro utilisé
1. Appuyez légèrement sur [ ] idans le menu 

Bluetooth pour sélectionner <Mobile Phone>
(Téléphone mobile), puis sur [ ].

Le menu du téléphone portable s’affi che.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Redial> (Recomp), puis sur [ ].
L’appel vers le dernier numéro utilisé est émis.

L’historique des appels récents peut s’affi cher 
selon le modèle. Sélectionnez le dernier numéro de 
l’historique.

Connect to Mobile Phone
Redial
Call by Number
Call History

Mobile Phone

Connect to Mobile Phone
Redial
Call by Number
Call History

Mobile Phone

REMARQUE
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)
Utilisation du lecteur pour émettre un appel
1. Appuyez légèrement sur [ ] idans le menu 

Bluetooth pour sélectionner <Mobile Phone>
(Téléphone mobile), puis sur [ ].

Le menu du téléphone portable s’affi che.

2. Appuyez sur le bouton [ ] pour sélectionner 
<Call by Number> (Appeler via n°), puis 
appuyez sur [ ].

La fenêtre de saisie du numéro de téléphone s’affi che.

3. Utilisez [ ] et [ ] pour saisir le numéro de téléphone de la 
personne à contacter.

4. Utilisez [ ] pour sélectionner < >, puis appuyez sur [ ].
L’appel vers la personne en question est émis.

Si le téléphone portable connecté possède des raccourcis, vous pouvez 
directement passer un appel sur le lecteur en appuyant longuement sur le 
dernier chiffre du raccourci.

Fin de l’appel
Appuyez légèrement sur [ ] pour sélectionner < > puis sur [ ].

La communication est interrompue.

Connect to Mobile Phone
Redial
Call by Number
Call History

Mobile Phone

REMARQUE
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)
Effectuer un appel à partir du répertoire
1. Appuyez légèrement sur [ ] idans le menu 

Bluetooth pour sélectionner <Mobile Phone>
(Téléphone mobile), puis sur [ ].

Le menu du téléphone portable s’affi che.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Call History> (Historique des appels) , puis sur 
[ ].

Le répertoire s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner le numéro voulu, puis 
sur [ ].

L’appel vers la personne en question est émis.

Suppression d’un numéro de téléphone dans le répertoire
1. Appuyez légèrement sur [ ] dans <Call History> (Historique 

des appels) pour sélectionner le numéro de téléphone à 
supprimer, puis sur [ ].

2. Appuyez légèrement sur [ ] pour sélectionner <Delete> (Supprimer), 
puis sur [ ].

Si vous souhaitez supprimer tous les numéros de votre répertoire, sélectionnez 
<Delete All> (Supprimer tous).
Une fenêtre de confi rmation s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner <Yes> (Oui), puis 
sur [ ].

Le numéro sélectionné est supprimé.

Connect to Mobile Phone
Redial
Call by Number
Call History

Mobile Phone



utiliser la fonction bluetooth_ 99

UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)
Répondre au téléphone

1. Lorsque vous recevez un appel, le message <Connect?>
(Se Connecter ?) s’affi che.

2. Appuyez légèrement sur [ ] sélectionner <Yes> (Oui), puis sur [ ].
Vous pouvez alors démarrer une conversation.

Pour basculer vers le téléphone portable lorsque vous parlez sur 
le lecteur (YP-T10)

Pendant que vous parlez sur le lecteur, appuyez légèrement légèrement 
sur [ ] pour sélectionner < > puis sur [ ].

Vous pouvez alors continuer la conversation sur le téléphone mobile.

Pour basculer vers le lecteur (YP-T10) lorsque vous parlez sur le 
téléphone portable

Pendant que vous parlez sur le téléphone portable, appuyez légèrement 
sur [ ] pour sélectionner < > puis appuyez sur [ ].

Vous pouvez alors continuer la conversation sur le kit Mains libres.

Réglage du volume

Pendant que vous parlez sur le téléphone en mode mains libres, appuyez 
légèrement sur [ ] pour régler le volume.

Vous pouvez régler le volume sur une valeur comprise entre 0 et 30.

Vous ne pouvez pas répondre à un appel en vous servant du kit mains libres  
 (YP-T10) pendant un enregistrement.REMARQUE
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TRANSFERT DE FICHERS VERS/DEPUIS UN PERIPHERIQUE 
BLUETOOTH
Vous pouvez transférer des fi chiers musicaux, photo ou vidéo depuis des 
périphériques externes compatibles avec la fonction Bluetooth (lecteur MP3, 
téléphone portable, etc.) vers le lecteur et inversement.

Avant de démarrer - Si le lecteur est relié aux écouteurs stéréo Bluetooth ou à un téléphone 
mobile, commencez par interrompre la connexion.
Assurez-vous que le périphérique Bluetooth à connecter est prêt pour l'association. 
(reportez-vous au manuel d’utilisation de l’appareil)
Vérifi ez que le périphérique Bluetooth prend en charge la fonction de transfert de 
fi chiers (reportez-vous au manuel d’utilisation de l’appareil).

Enregistrement d’un périphérique externe
(un seul enregistrement suffi t)
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur [ ] pour sélectionner 

<Bluetooth>, puis sur [ ].
La fonction <Bluetooth Mode> (Mode Bluetooth) est 
réglée sur <On> (Marche).
L’icône  s’allume.

3. Réglez le périphérique externe de telle sorte qu'il 
soit prêt pour l'association.

Pour savoir comment préparer le périphérique externe 
en vue de l'association, reportez-vous au manuel d'utilisation de l'appareil.

4. Appuyez légèrement sur [ ] pour sélectionner 
<File Transfer> (Transfert de Fichiers), puis sur [ ].

Le périphérique à enregistrer apparaît dans la liste.
 Le message <Search New Device> (Rech. nv périph) s’affi che à l’écran si un 
périphérique a été préalablement associé au lecteur. Sélectionnez <Search 
New Device> (Rech. nv périph) pour rechercher un nouveau périphérique à 
associer.

Stereo Headset
Mobile Phone
File Transfer
Bluetooth Mode
Bluetooth Settings

Bluetooth



utiliser la fonction bluetooth_ 101

TRANSFERT DE FICHERS VERS/DEPUIS UN PERIPHERIQUE 
BLUETOOTH (Suite)

Pour enregistrer un périphérique externe sur le lecteur (Suite)

5. Appuyez légèrement sur [ ] pour sélectionner 
un périphérique à enregistrer, puis sur [ ].

La fenêtre de saisie du mot de passe s’affi che si le mot 
de passe du périphérique externe est autre que 0000. 
Reportez-vous au manuel d’utilisation du périphérique 
externe pour en savoir plus sur le mot de passe.

6. Saisissez le mot de passe lorsque la fenêtre 
de saisie correspondante s’affi che sur le 
périphérique externe.

Saisissez le même mot de passe qu’à l’étape 5 ci-dessus.
Une fois le couplage terminé, l’écran de transfert des fi chiers s’affi che.
Reportez-vous à l’étape 3 de la page 102 pour transférer des fi chiers du 
lecteur vers un périphérique externe.

Les chiffres du mot de passe peuvent varier en fonction du périphérique 
externe (reportez-vous au manuel d'utilisation de l'appareil).
Certaines fonctions risquent de ne pas être pleinement opérationnelles 
si vous utilisez un périphérique Bluetooth autre que le YP-T10 pour le 
transfert de fi chiers.

REMARQUE

File Transfer

Searching (0)
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TRANSFERT DE FICHERS VERS/DEPUIS UN PERIPHERIQUE 
BLUETOOTH (Suite)

Transfert d’un fi chier depuis le lecteur vers le périphérique externe
Avant de démarrer - Si vous ne parvenez pas à trouver le périphérique 
externe à relier, commencez par l’enregistrer sur le lecteur. Reportez-vous 
à la page 100.
Assurez-vous que le périphérique Bluetooth à connecter est prêt pour 
l'association. (reportez-vous au manuel d’utilisation de l’appareil).

1. Sur l'écran Bluetooth, appuyez légèrement 
sur [ ] pour sélectionner <File Transfer>
(Transfert de Fichiers), puis sur [ ].

2. Appuyez légèrement sur [ ] pour sélectionner 
le périphérique externe à connecter, puis sur [ ].

Une fois la connexion effectuée, l’écran de transfert 
des fi chiers s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
le dossier souhaité, puis sur [ ].

4. Appuyez légèrement sur [ ] pour sélectionner le 
fi chier souhaité, puis sur [ ].

Le fi chier sélectionné est transféré vers le périphérique externe.

Lorsque le transfert de fi chiers est terminé, appuyez légèrement sur [ ]
pour quitter le mode de transfert de fi chiers. Reportez-vous à la page 103.
Les fi chiers DRM (chargeables) ne peuvent être lus sur le lecteur.
Vous pouvez mettre fi n à la connexion en mettant le lecteur ou le 
périphérique externe hors tension, puis de nouveau sous tension. Si la 
connexion est interrompue, reportez-vous aux étapes ci-dessus pour la 
rétablir.

REMARQUE

Ex. : écran <File 
Transfer> (Transfert 
de Fichiers) du lecteur

File Transfer

Music
Playlists
Video
Pictures
Datacasts
Texts
Games
Recorded Files
Received Files
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TRANSFERT DE FICHERS VERS/DEPUIS UN PERIPHERIQUE 
BLUETOOTH (Suite)

Annulation d’un transfert de fi chier
Appuyez légèrement sur [ ] pendant le transfert.

Le transfert du fi chier est interrompu.

Quitter le mode de transfert de fi chiers

1. Appuyez longuement sur [ ] dans la liste de fi chiers.
Chaque fois que vous appuyez longuement sur [ ], le lecteur revient à 
l'écran précédent et la fenêtre de fermeture du transfert de fi chiers apparaît.

2. Appuyez légèrement sur [ ] pour sélectionner <Yes> (Oui), puis 
sur [ ].

Vous avez quitté le mode de transfert de fi chiers.
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TRANSFERT DE FICHERS VERS/DEPUIS UN PERIPHERIQUE 
BLUETOOTH (Suite)

Transfert d’un fi chier du périphérique externe vers le lecteur
Si vous souhaitez transférer un fi chier externe vers le lecteur, 
commencez par le préparer en vue du couplage.

Avant de démarrer - Si le lecteur est relié aux écouteurs stéréo Bluetooth ou à un 
téléphone mobile, commencez par interrompre la connexion.
Assurez-vous que le périphérique Bluetooth à connecter est prêt pour 
l'association. (reportez-vous au manuel d’utilisation de l’appareil). 
Vérifi ez que le périphérique Bluetooth prend en charge la fonction de 
transfert de fi chiers (reportez-vous au manuel d’utilisation de l’appareil).
Sélectionnez <Discoverable> (“Découverte” possible) sous <Bluetooth 
Settings> (Paramètres Bluetooth)  <Discover option> (Options du mode 
“découverte”).  Reportez-vous à la page 106.

1. Appuyez longuement sur [ ] pour accéder à l’écran du menu 
principal.

2. Appuyez légèrement sur [ ] pour sélectionner <Bluetooth>, puis 
sur [ ].

La fonction <Bluetooth Mode> (Mode Bluetooth) est réglée sur <On> 
(Marche).
L’icône  s’allume.
Vous pouvez transférer un fi chier du périphérique externe vers le lecteur.
Pour coupler le périphérique externe avec le lecteur afi n d’effectuer des 
transferts, reportez-vous au manuel d’utilisation de l’appareil.
Les fi chiers transférés vers le lecteur sont enregistrés dans le dossier <File 
Browser> (Dossier Navigateur)  <Received Files> (Fichiers Reçus).
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UTILISATION DU MENU BLUETOOTH
Déconnecter le périphérique Bluetooth
1. Appuyez légèrement sur [ ] sur l’écran 

Bluetooth.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Disconnect> (Déconnecté), puis sur [ ].

La fenêtre de confi rmation de la déconnexion s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Yes> (Oui), puis sur [ ].

Le périphérique actuellement connecté est 
déconnecté.

Vérifi er le périphérique Bluetooth connecté
1. Appuyez légèrement sur [ ] sur l’écran 

Bluetooth.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Connected Device> (Périph. connecté), 
puis sur [ ].

Vous pouvez affi cher les informations relatives au 
périphérique connecté.

Vous ne pouvez déconnecter ou vérifi er l’appareil connecté qu’en 
connectant des écouteurs stéréo ou un téléphone mobile Bluetooth.REMARQUE

Disconnect
Connected  Device

Disconnect
Connected Device
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REGLAGES BLUETOOTH
Avant de démarrer- Réglez la fonction <Bluetooth Mode> (Mode Bluetooth) sur 

<On> (Marche).

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur [ ] pour sélectionner 
<Bluetooth> (Bluetooth), puis sur [ ].

3. Appuyez légèrement sur [ ] pour sélectionner 
<Bluetooth Settings> (Paramètres Bluetooth), 
puis sur [ ].

Le menu <Bluetooth Settings> (Paramètres Bluetooth) s’affi che.

4. Les boutons [ ] et [ ] servent à régler des fonctions.

Options de réglage Bluetooth
Discover Option (Options du mode “découverte”) : Vous pouvez régler le 
périphérique Bluetooth de telle sorte qu'il détecte ce lecteur. Choisissez <Discoverable> 
("Découverte" possible) pour activer la détection et <Non-Discoverable> (Non Décelable) 
pour la désactiver.
Search Timeout (Délai d’Attente Recherche Dépassé) : Vous permet de régler la durée 
de recherche d’un nouveau périphérique. Après la recherche de l’heure, la recherche 
d'un nouveau périphérique est lancée pour la durée défi nie. Choisissez entre <10sec>, 
<20sec>, <30sec>, <45sec> et <60sec>.
Delete Device (Supprimer le Périphérique) : Vous permet de supprimer un périphérique 
enregistré sur le lecteur. Reportez-vous à la page 107. 
Sélectionnez <Delete All> (Supprimer tous) pour supprimer tous les périphériques 
enregistrés.
My Device Info (Informations de Mon Périphérique) : Vous pouvez vérifi er le nom et 
l’adresse de votre lecteur.

Stereo Headset
Mobile Phone
File Transfer
Bluetooth Mode
Bluetooth Settings

Bluetooth
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REGLAGES BLUETOOTH (Suite)

Supprimer un périphérique Bluetooth
1. Appuyez légèrement sur [ ] pour sélectionner <Delete

Device> (Supprimer le Périphérique), puis sur [ ].
La liste des périphériques enregistrés s'affi che.

2. Appuyez légèrement sur [ ] pour sélectionner un 
périphérique à supprimer, puis sur [ ].

Si vous souhaitez supprimer tous les périphériques 
enregistrés, sélectionnez <Delete All> (Supprimer tous).

3. Appuyez légèrement sur [ ] pour sélectionner 
<Yes> (Oui), puis sur [ ].

Le périphérique sélectionné est supprimé.

Renommer un périphérique Bluetooth
1. Appuyez légèrement sur [ ] pour sélectionner 

<My Device Info> (Informations de Mon 
Périphérique), puis sur [ ].

2. Appuyez légèrement sur [ ].
La fenêtre Informations de Mon périphérique s’affi che.

3. Appuyez légèrement sur [ ] pour sélectionner 
<Edit Device Name> (Modifi er le nom du 
périphérique), puis sur [ ].

La fenêtre Edit Device Name (Modifi er le nom du 
périphérique) apparaît.

4. Utilisez les boutons [ ] et [ ] pour renommer le périphérique.
[ ] : Permet de passer du mode de saisie Chiffre au mode de saisie Lettres 

majuscules et minuscules Anglais.
[ ] : Permet de supprimer les caractères l’un après l’autre.
[ ] : Confi rmez votre modifi cation.
Ex. : pour saisir « YPS5 »
-Allez sur l’icône correspondante et appuyez dessus.

(une fois) (trois fois) (une fois) (trois fois) (deux fois) 
(une fois)

Edit Device Name

Discover Option
Search Timeout
Delete Device
My Device Info.

Bluetooth Settings
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dépannage
Si vous rencontrez un problème avec votre nouveau lecteur MP3, des 
solutions vous sont proposées dans cette liste. Si le problème persiste, 
contactez le service clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume 
pas.

• L’appareil ne s’allumera pas si la batterie est entièrement 
déchargée. Rechargez la batterie et remettez l’appareil 
sous tension.

• Appuyez sur le bouton de réinitialisation.

Les boutons ne 
fonctionnent pas.

• Vérifi ez si l’interrupteur  est dirigé dans le 
sens de la fl èche. 

• Vérifi ez que vous avez appuyé sur le bouton adéquat, 
puis essayez à nouveau.

• Appuyez sur le bouton de réinitialisation.

L’écran ne s’allume 
pas.

• Il se peut que les données affi chées à l’écran ne soient 
pas visibles sous les rayons directs du soleil.

• Si <Display Off> (Affi ch. désactivé) est sélectionné dans 
<Settings> (Paramètres) <Display> (Affi cher), l’écran 
s’éteint.
Appuyez sur un bouton et vérifi ez si l’écran s’allume.
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PROBLÈME SOLUTION

L’alimentation est 
coupée.

• Vérifi ez l’état de charge de la batterie.
• L’alimentation se coupe automatiquement lorsque la 

batterie est entièrement déchargée. Rechargez la batterie.
• Si <Auto Power Off> (Extinction auto) est sélectionné 

dans <Settings> (Paramètres) <System> (Système),
l’alimentation est coupée lorsque le lecteur est en mode 
Pause. Allumez le lecteur.

La durée de vie de 
la batterie diffère de 
celle indiquée dans le 
manuel.

• L’autonomie de la batterie peut varier en fonction du mode 
son utilisé et du réglage de l’affi chage.

• La durée de vie de la batterie peut être réduite si vous 
exposez le lecteur à des températures basses ou élevées 
pendant des périodes prolongées.

Dysfonctionnement du 
programme Samsung 
Media Studio

• Vérifi ez que votre ordinateur dispose de la confi guration 
requise.

La connexion à 
l’ordinateur est 
désactivée.

• Assurez-vous que le câble USB est branché correctement 
et essayez à nouveau.

• Appuyez sur le menu <Démarrer> de la barre d’outil de 
votre ordinateur pour lancer la mise à jour Windows. 
Redémarrez votre ordinateur et rebranchez l’appareil.

Le taux de transfert du 
fi chier est trop lent.

• Si vous avez formaté votre lecteur sous Windows 2000, le 
transfert du fi chier peut être lent. Formatez votre lecteur 
sous Windows XP ou Vista et essayez à nouveau.

• Si plusieurs programmes sont ouverts sur votre ordinateur 
(dont <Samsung Media Studio>), le taux de transfert du 
fi chier sera ralenti. Quittez les programmes que vous 
n’utilisez pas et procédez à nouveau au transfert.



110 _ dépannage

PROBLÈME SOLUTION

Le lecteur ne 
fonctionne pas.

• Vérifi ez que le fi chier disponible a bien été enregistré dans 
la mémoire.

• Assurez-vous que le fi chier musical n’est pas endommagé.
• Vérifi ez que la puissance de la batterie est suffi sante.

Les fi chiers ne se 
téléchargent pas.

• Vérifi ez que le câble USB est correctement branché. 
Rebranchez-le au besoin.

• Assurez-vous qu’il reste de l’espace disponible sur la 
mémoire.

• Appuyez sur le bouton de réinitialisation.

Des fi chiers ou des 
données manquent.

• Vérifi ez que le câble USB n’a pas été débranché durant le 
transfert du fi chier ou des données. 
Si tel est le cas, les fi chiers/données mais également 
l’appareil risquent d’être endommagés. 
Vous devez faire preuve d’une extrême prudence à cet 
égard car Samsung ne saurait en aucun cas être tenu 
responsable de la perte des données.

Affi chage anormal de la 
durée de lecture.

• Vérifi ez que le fi chier est au format VBR (débit binaire 
variable).

Affi chage anormal du nom 
de fi chier.

• Allez dans <Settings> (Paramètres) <Language>
(Langue) <ID3 Tag> depuis le Menu principal et 
défi nissez la langue qui vous convient. Reportez-vous à la 
page 28.

L’appareil est chaud.
• Les phases de chargement peuvent générer de la chaleur. 

Cela n’a aucune incidence sur la durée de vie de l’appareil 
ou sur son fonctionnement.

Un message s’affi che 
pendant le visionnage 
d’une vidéo

• Essayez à nouveau de télécharger le clip vidéo en 
passant par le logiciel Samsung Media Studio.
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PROBLÈME SOLUTION

La connexion Bluetooth 
ne fonctionne pas

• Vérifi ez que les écouteurs stéréo sont certifi és Bluetooth. 
Les kits Mains libres mono ne sont pas pris en charge.

• La connexion Bluetooth peut être désactivée si vous 
éteignez et rallumez le lecteur ou les écouteurs stéréo. 
Dans ce cas, essayez de vous reconnecter.

• Si vous souhaitez parler sur votre téléphone mobile, 
assurez-vous d’avoir interrompu les connexions 
Bluetooth entre le lecteur et les écouteurs stéréo.

• Si vous souhaitez parler sur votre téléphone portable, 
vérifi ez que vous avez sélectionné la fonction 
<Discoverable> (Décelable) dans <Bluetooth 
Settings> (Paramètres Bluetooth) <Discover 
Option> (Option du mode « Découverte »).
Si la fonction est réglée sur <Non-Discoverable>
(Non décelable), le téléphone mobile ne peut trouver 
le lecteur.
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annexe
ARBORESCENCE DES MENUS
Voici une rapide présentation de la façon dont les menus et les fonctions sont 
organisés dans votre nouveau lecteur MP3.

Ecran de sélection du menu

Music Videos Pictures FM
Radio Datacasts Prime

Pack
File

Browser Bluetooth Settings

Text Stereo
Headset Menu Style

Voice REC Mobile Phone Sound

Games File Transfer Display

Address Book Bluetooth
Mode

Library
Update

Bluetooth
Settings Language

Date&Time

System



annexe _ 113

CARACTÉRISTIQUES DU PRODUIT
Nom du modèle YP-T10

Puissance nominale 5,0 V CC / 500 mA
Alimentation de la batterie 

intégrée 550 mAh / 3,7 V CC

Fichier Compatibilité

AUDIO : MPEG1/2/2.5 Couche 3 (8 kbps~ 320 
kbps, 22 kHz ~ 48 kHz), WMA (8 kbps ~ 
320 kbps, 8 kHz ~48 kHz), Ogg (Q0 ~ Q10), 
AAC-LC (16 kbps ~ 256 kbps, 8 KHz ~ 48 
kHz), AAC-Plus (16 kbps~ 256 kbps, 16 
kHz~ 44,1 kHz), AAC-Plus (amélioré) (16 
kbps ~ 56 kbps, 32 kHz ~ 44,1 kHz)

VIDEO : SVI (vidéo : MPEG4, Audio : MP3 (44,1 kHz,
128 kbps), 
WMV(Vidéo : WMV9 Profi l simple,  Audio : 
WMA Spec (860 kbps maxi.), 
Résolution : 320X240, 
Vitesse d’enregistrement : 30 fps)

IMAGE : JPEG (ISO/IEC 10918-1/Annexe F – Mode 
de fonctionnement séquentiel DCT)

Sortie des écouteurs 20 mW/Ch. (basé sur 16 )
Bande de fréquences de 

la sortie 20Hz à 20KHz

Rapport signal-bruit 90 dB avec fi ltre passe bas 20 kHz (sur la 
base de 1 KHz, 0 dB)

Durée de lecture
Jusqu’à 30 heures de lecture musicale (sur la 
base de : MP3 128 kbps, Volume 15, Mode sonore 
normal), jusqu’à 4 heures de lecture vidéo

Plage de températures de 
fonctionnement -5~35°C (23~95°F)



114 _ annexe

Etui Plastique , Aluminium
Poids 43g

Dimensions (L x H x P) 41,5 X 96 X 7,9 mm

Radio FM
Fréquence FM 87,5~108,0MHz T.H.D. FM 1%

Rapport signal 
FM 50 dB Sensibilité

FM utile 30dB

Système sans fi l
Type d’émission F1D

Puissance RF 1,8mW
Fréquence d’émission 2 402 à 2 480 MHz

Fréquence de réception 2 402 à 2 480 MHz
Nombre de canaux 79 ch

Température -10°C à +50°C(14 ~ 122°F)
Système de modulation GFSK
Mode de communication bidirectionnel non simultané

Humidité 95%
Spec Version Supported 2,0

Module BTEM48B2SA

Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré 
sans notifi cation préalable.
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LICENCE D’UTILISATION
L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence 
sous certains droits de propriété intellectuelle de parties tierces. Cette licence 
est limitée à une utilisation privée non commerciale par l’utilisateur fi nal pour les 
contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à 
un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-
3 ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou 
décoder des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des 
fonctions du produit qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou 
ISO/IEC 13818-3.



COMMENT CONTACTER SAMSUNG DANS LE MONDE
Si vous avez des suggestions ou des questions concernant les produits 
Samsung, veuillez contacter le Service Consommateurs Samsung.

Pays Centre d’assistance à la clientèle Site Internet
CANADA 1-800-SAMSUNG(726-7864) www.samsung.com/ca
MEXICO 01-800-SAMSUNG(726-7864) www.samsung.com
U.S.A 1-800-SAMSUNG(726-7864) www.samsung.com
ARGENTINE 0800-333-3733 www.samsung.com/ar
BRAZIL 0800-124-421 , 4004-0000 www.samsung.com
CHILE 800-SAMSUNG(726-7864) www.samsung.com/cl
NICARAGUA 00-1800-5077267
HONDURAS 800-7919267
COSTA RICA 0-800-507-7267 www.samsung.com/latin
ECUADOR 1-800-10-7267 www.samsung.com/latin
EL SALVADOR 800-6225 www.samsung.com/latin
GUATEMALA 1-800-299-0013 www.samsung.com/latin
JAMAICA 1-800-234-7267 www.samsung.com/latin
PANAMA 800-7267 www.samsung.com/latin
PUERTO RICO 1-800-682-3180 www.samsung.com/latin
REP. DOMINICA 1-800-751-2676 www.samsung.com/latin
TRINIDAD & TOBAGO 1-800-SAMSUNG(726-7864) www.samsung.com/latin
VENEZUELA 0-800-100-5303 www.samsung.com/latin
COLOMBIA 01-8000112112 www.samsung.com.co
BELGIUM 0032 (0)2 201 24 18 www.samsung.com/be
CZECH REPUBLIC 844 000 844 www.samsung.com/cz
DENMARK 70 70 19 70 www.samsung.com/dk
FINLAND 030-6227 515 www.samsung.com/fi

FRANCE 3260 SAMSUNG (  0,15/Min),
08 25 08 65 65 (  0,15/Min)

www.samsung.com

GERMANY 01805 - SAMSUNG(726-7864) (  0,14/Min) www.samsung.com
HUNGARY 06-80-SAMSUNG(726-7864) www.samsung.com
ITALIA 800-SAMSUNG(726-7864) www.samsung.com
LUXEMBURG 0035 (0)2 261 03 710 www.samsung.com/be
NETHERLANDS 0900-SAMSUNG(726-7864) (  0,10/Min) www.samsung.com/nl



NORWAY 815-56 480 www.samsung.com/no
POLAND 0 801 801 881 , 022-607-93-33 www.samsung.com/pl
PORTUGAL 80820-SAMSUNG(726-7864) www.samsung.com/pt
SLOVAKIA 0800-SAMSUNG(726-7864) www.samsung.com/sk
SPAIN 902 10 11 30 www.samsung.com
SWEDEN 0771-400 200 www.samsung.com/se
U.K 0845 SAMSUNG (7267864) www.samsung.com
EIRE 0818 717 100 www.samsung.com/ie
AUSTRIA 0800-SAMSUNG(726-7864) www.samsung.com/at
SWITZERLAND 0800-SAMSUNG(726-7864) www.samsung.com/ch
RUSSIA 8-800-555-55-55 www.samsung.com
KAZAHSTAN 8-10-800-500-55-500 www.samsung.kz
UZBEKISTAN 8-10-800-500-55-500 www.samsung.uz
KYRGYZSTAN 00-800-500-55-500
TADJIKISTAN 8-10-800-500-55-500
UKRAINE 8-800-502-0000 www.samsung.com
LITHUANIA 8-800-77777 www.samsung.lt
LATVIA 800-7267 www.samsung.com/lv
ESTONIA 800-7267 www.samsung.ee
AUSTRALIA 1300 362 603 www.samsung.com
NEW ZEALAND 0800SAMSUNG(726-7864) www.samsung.com/nz
CHINA 800-810-5858 , 010-6475 1880 www.samsung.com
HONG KONG 3698-4698 www.samsung.com/hk
INDIA 3030 8282 , 1800 110011 www.samsung.com
INDONESIA 0800-112-8888 www.samsung.com
JAPAN 0120-327-527 www.samsung.com/jp
MALAYSIA 1800-88-9999 www.samsung.com/my
PHILIPPINES 1800-10-SAMSUNG(726-7864) www.samsung.com/ph
SINGAPORE 1800-SAMSUNG(726-7864) www.samsung.com
THAILAND 1800-29-3232 , 02-689-3232 www.samsung.com
TAIWAN 0800-329-999 www.samsung.com/tw
VIETNAM 1 800 588 889 www.samsung.com
TURKEY 444 77 11 www.samsung.com
SOUTH AFRICA 0860-SAMSUNG(726-7864 ) www.samsung.com
U.A.E 800-SAMSUNG (726-7864), 8000-4726 www.samsung.com

Pays Centre d’assistance à la clientèle Site Internet
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